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Introduction

Axiom is an enterprise performance management application with full-featured planning and reporting
functionality. Once the system has been configured to your organization's requirements, plan files and
reports are made accessible to end users. This guide explains how to work with spreadsheet-based plan
files and reports that have already been created by administrators and other power users.

» Intended audience

This guide is intended for all users of Axiom.

» What is covered in this guide?

This guide covers the following:
e Introduction to the Desktop Client user environment, including menus and basic navigation
e How to use spreadsheet-based plan files to develop planning data for your responsibility areas
e How to use spreadsheet-based reports to view Axiom data

* File output options

» What is not covered in this guide?
The following related topics are not covered in this guide:
e Basics of using the Web Client. For more information, see the Web Client User Guide.

e Creation and use of web reports and the Report Builder. For more information, see the Web
Reports Guide.

e Administration or file setup activities. For more information, see the other guides delivered with
the system.

All documentation for Axiom can also be accessed using the Axiom Help Files.

» Axiom Client applications

Users interact with Axiom using either the Desktop Client or the Web Client.
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Desktop Client The Desktop Client is the general name for the Axiom application that runs on
the client desktop. The Desktop Client provides access to spreadsheet-based
plan files, reports, and other supporting files. The Desktop Client also provides
access to full administration features for the Axiom platform, including
managing security, Scheduler, tables, imports/exports, file groups, and more.

There are two different versions of the Desktop Client:

¢ Excel Client. The Excel Client provides access to all Axiom features within a
Microsoft Excel interface.

¢ Windows Client. The Windows Client uses a .NET-based engine to emulate
the spreadsheet environment without requiring Microsoft Excel. It provides
full access to Axiom features, but certain spreadsheet features are limited.

Syntellis recommends the Windows Client as the primary client application for
all users who need access to the Desktop Client. Generally speaking, use of the
Excel Client should be reserved for spreadsheet file development, due to the
easy access to full spreadsheet functionality.

Web Client The Web Client provides browser-based access for Axiom, limited to certain
web-enabled features. The Web Client does not provide spreadsheet
functionality.

Using the Web Client, end users can access browser-based plan files and
reports. Certain system administration features are available in the Web Client,
such as limited Scheduler, security, and table management. Various Axiom
products also provide product administration features in the Web Client.

This guide discusses functionality that is available in the Axiom Desktop Client (Excel Client and Windows
Client). Screenshots of features may show either the Excel Client or the Windows Client. The Axiom
functionality is virtually identical in both environments.
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Desktop Client Basics

This section discusses the basics of working with the Axiom Desktop Client. The Desktop Client provides
full access to general Axiom administration features and file development features and is also used by
end users to work with spreadsheet-based plan files and reports.

The Desktop Client has two different options—the Excel Client and the Windows Client. Both clients can
be installed and launched from the Web Client. Use of the Excel Client requires Microsoft Excel to be
installed on the client machine. You must have security permission to the client to launch and use it.

The Excel Client and Windows Client support the same Axiom functionality. The primary difference
between the two clients is the spreadsheet interface and the level of support for spreadsheet
functionality. You can use any Desktop Client featurein both clients unless specifically stated.

Home page
All users have a home page that opens automatically when you log into Axiom.

The contents of your home page may vary depending on the security roles to which you are assigned
and the products to which you have access. If you have any questions about your home page, please
contact your system administrator.

» Desktop Client home page

The default label for the home page is Home. The name on the file tab may be different if your
administrator has assigned an alternate home page.

The home page may be configured as noncloseable, which means it is always open while you are
working in Axiom. If the home page is closeable, you can close and open it as follows:

e To close the home page, click the X button in the file tab or right-click the file tab and select
Close.

NOTE: The Close All and Close All But This options do not close the home page; you must
close it individually. If you use the Axiom Excel Client and the home page is the last open file,
closing the home page closes the application.
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e To reopen the home page in the current session, click Show Home in the Display group on the
Axiom tab. You can also use this button to jump directly to the home page when multiple files are
currently open.

NOTE: In systems with installed products, this button may be located on the Main tab.

Axiom menu

In the Desktop Client, you can access all major Axiom files and features using the Axiom tab on the
ribbon.

AXIOM Home

¥Z]Budget - ID E a m Hsave - [ZRefresh »  “EzQuickFilter | ¥=APrint -~  [53File Processing » | 2} Show Home [, protect - 9 Dx
.'E Capital Requests = = I@C"aﬂge View ~ Q:Ik Drill ~ D Forms ~ ||=D Snapshet ¥| Formula Bar
Reports Tables Imports Manage 5 Help Close Axiom
" - . . > GoTo -~ ¥| Freeze Panes W5 E-ma Headings - Software ~

Example Axiom menu

The Axiom tab contains the following groups:

Group Description

File Groups Access plan files, templates, and drivers. Create and process plan files.

Reports Access existing reports and create new reports.

Administration Manage tables, imports, file groups, security, and other system administration
features.

File Options Perform actions on Axiom files, such as saving the file, refreshing data, and

inserting planning rows.

File Output Perform file output actions on Axiom files, such as taking snapshot copies or
using file processing.

Display Manage display options for the Axiom user environment. Show or hide the home
page, the formula bar, or sheet headings.

Advanced Access advanced options.
Help Open Axiom Help and view information about the current Axiom system.
Exit Close Axiom.

NOTE: This topic discusses the default contents of the Axiom ribbon tab. You can customize this
ribbon tab per installation or remove and replace it with other custom ribbon tabs. You may also be
assigned additional custom ribbon tabs that provide access to Axiom functionality.
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The specific groups and features that are available on the menu depend on your security settings. For

example, the File Groups group only displays the file groups to which you have access, and only allows
opening plan files if you have been granted the security rights to access other file group items such as

drivers and templates. Most users do not see the Administration group or the Advanced group unless
they are granted access to a feature in that area.

Spreadsheet features are available on other ribbon tabs to perform spreadsheet formatting and other
related tasks. If you use the Excel Client, you have access to all of the typicall Microsoft Excel ribbon
tabs. If you use the Windows Client, a Home tab provides access to commonly used spreadsheet
features.

NOTES:

e Administrators have access to a second Axiom-related tab, which is named Axiom Designer.
Use this tab to assist with file development.

¢ When using the Axiom Excel Client, each file opens within its own window, and each window
maintains its own set of ribbon tabs and task panes. As you switch windows, the current state
of the ribbon may be different in each window. For example, you may have the Home tab
active in one window, but if you switch to another window, the Axiom tab is still active.

Axiom file tabs

In the Desktop Client, you can open multiple files at a time. Each file that you open—whether it is an
Axiom file or a regular Excel spreadsheet—is represented by an Axiom file tab. These tabs are located
below the ribbon and above the spreadsheet area.

You can quickly navigate between open files using the Axiom file tabs. You can also perform certain
basic file actions directly from these tabs.

Axicm Software - Training Video - Budget_40000.xlsx

AllH
“ AXIOM = HELP  Home

p@ Budget D E Save - 4 @Print - ﬁ Show Home
p'E Capital Requests I@ Change View = Em Add Row(s) = ||=|:| Snapshot Formula Bar
Reports —~ m .
- = Golo - Gl Drill - Wz E-mai Headings
» A| Home [E] Income Statement By Monith ¥Z] [BGT20] 40000

40000 Los Angeles - Store 34

Current View: Standard view Total

FY17
Account | Method Actual J

Explorer
m
=
(=8
U=]
s

Multiple file tabs open in the Axiom Windows Client
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The tab displays the name of the file and an icon identifying the file type. You can hover your cursor
over the tab to view a tooltip with more information about the file. For example, if the file is a plan file,
the tooltip shows to which file group the file belongs.

You can navigate between files by clicking the tabs. To close a file, click the X icon in the right-hand side
of the tab. Additional file close options are available on the right-click menu.

» Opening multiple files in the Axiom Excel Client

When using the Axiom Windows Client, multiple files open within the same window. As you move from
file to file, you change the active file within the current window.

Microsoft Excel does not support the ability to open multiple workbooks within the same window.
Therefore, when you open multiple files in the Axiom Excel Client, each file opens in a new Excel
window. The Axiom file tabs are displayed so that you have access to the right-click menu; however,
when you click a file tab, you change windows. This action may look different from the behavior when
all of the files are open in the same window. As an alternative to the file tabs, you can also switch
between files (windows) by using the Windows task bar or by pressing Alt+Tab to move through open
windows.

The one-file-per-window behavior of Excel has the following functionality impacts:

e With the exception of the home page, you cannot open web-enabled files as tabs within the
Axiom Excel Client. Instead, these files open in the browser and includes Axiom forms, web
reports, and data diagrams.

e The active ribbon tab and the active task pane are managed independently for each open
window. As you change windows, your active ribbon and active task pane may be different.

» Performing actions from the file tab

You can right-click a file tab to perform one of the following actions.

NOTE: If you are use the Axiom Excel Client, right-click options are only available on the currently
active file. In the Axiom Windows Client, right-click options are available on all open files.
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Action Description

Save You can save the file using one of the following options:
e Save: Save the file and its data.
e Save File Only: Save only the file; do not perform a save-to-database. This
option is not available to virtual plan files.
e Save Data Only: Perform a save-to-database, but do not save the file.

NOTE: In most cases, you should select Save, and Axiom performs all save
operations that you have rights to perform and that the file allows. Avoid
saving only the file or only the data unless you understand the potential
consequences. For more details, see the save discussion for the file type that
you are saving (for example, report or plan file).

Save As You can save a copy of the file locally or to the Axiom file system within the

database:

e Save As (Local File): Save a copy of the file to any local or network folder
that you have access to. This option is not available to plan files.
If you save an Axiom file as a local file, it is no longer managed by Axiom.
Additionally, if you open the local file within Axiom, most functionality is
not available. You should only save a file locally to import it into another
Axiom system.
In the Axiom Excel Client, you can save the file using any file format that
your Excel version supports. In the Windows Client, you can save the file
as XLSM, XLSX, or XLS.
NOTE: You can enable or disable the ability to save as a local file on a per-
system basis. For more information on system configuration settings, see
the System Administration Guide.

e Save As (Repository): Save a copy of the file to the Reports Library in the
Axiom database (or to another eligible location, depending on the type of
file being saved and your folder permissions). You must have read/write
permissions to at least one folder to use this option. This option is not
available for plan files.

Close Close the current file. This option is not available for startup files that are
configured as noncloseable.

Close All Close all files except the home page and any noncloseable startup files.

Close All But This Close all files except the current file, the home page, and any noncloseable
startup files.

Add to Favorites Add the file to your list of favorites.

» File icons in the navigation pane

The following icons are displayed on the file tabs to identify files in the navigation pane.
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Icon Description Tooltip Contents

Al Home file e File name

¢ File location (in the Axiom file
system)

¢ Creation date

E| Report file ¢ File name

¢ File location (in the Axiom file

system)

¢ Creation date
= Plan file ¢ File name

¢ File group

¢ Plan file code

¢ Creation date
Template file ¢ File name

¢ File group

¢ Creation date
Lo Driver file * File name

¢ File group

¢ Creation date

= Table opened in a spreadsheet ¢ Table name
o Filter
B Excel file ¢ File name

¢ File location

¢ Creation date

Axiom Assistant task panes

The Axiom Assistant area provides quick and easy access to Axiom files and features as you work in the
Desktop Client. A variety of task panes are available to help you perform general and context-sensitive
tasks. Additionally, system administrators can create customized task panes for use in this area.

The Axiom Assistant area is located on the left side of the application, below the ribbon and to the left
of any opened files. By default, the area is expanded and you can work with any of its available task
panes by clicking the side-tabs along the left edge of the pane.
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Example Axiom Assistant area

» Available task panes

The task panes available to you in the Axiom Assistant area d

< Axiomn Assistant 1 S— A| Home V= [BGT20] 40000 X
My Files ~ ||AE103 -] |
il ¢ Favorites R
% » “El Recent
& [Fica N 40000 Los Angeles - Store 34
fle aroups Current View: Standard view
vz Budget
5 VZ] Capital Requests Account
o
g Libraries o)
- Statistics
4 Reports Libra
s = b 95000 Volumes
§ Total Statistics
&

epend on your system configuration and

your security permissions. The following task panes may be available:

Task pane Description

Data Source Helper tool to build data sources, such

Availability

This task pane is system-controlled

Assistant as RefreshVariables, DataLookup, and and is displayed if you have the
Grid. appropriate security permissions
and the file is an Axiom file.
Explorer Open files and other items to which you This task pane is included by

have access, including favorites.

default, butcan be disabled in your
system or restricted to only certain
users.

Configure and perform file processing
for an Axiom file, such as performing
multipass processing, file collection, or
batch processing.

File Processing

This task pane is system-controlled
and is displayed if you have the
appropriate security permissions
and the file is enabled for File
Processing.
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Task pane

Form Assistant

Messages

Notifications

Process

Sheet Assistant

Table

<Custom Task
Panes>

Description

Configure form settings for an Axiom
file, and preview the form.

View comments about the current
document, and add comments.

View alert and system notifications and
open associated files.

View process information and complete

process tasks. By default, this task
paneis displayed if it is relevant to you
(for example if you are the assigned
owner of a process task).

Configure workbook and worksheet
settings for an Axiom file, including
Axiom queries.

View table details, set a filter, and
refresh the currently opened table.

Your organization may have defined one

or more custom task panes for your
system.

Availability

This task pane is system-controlled
and is displayed if you have the
appropriate security permissions
and the file is enabled for Axiom
forms.

This task pane is system-controlled
and is displayed for all eligible
documents.

This task pane is system-controlled
and is displayed if you have any
active notifications.

This task pane is included by
default, but can be disabled in your
system.

This task pane is system-controlled
and is displayed if you have the
appropriate security permissions
and the file is an Axiom file.

This task pane is system-controlled
and displays when using Open
Table in Spreadsheet.

Custom task panes may open
automatically when Axiom is
launched, or you may have access
to the Task Panes Library to open
certain task panes as needed.

You cannot manually change the order of task panes in the Axiom Assistant area. Your system
administrator has specified an order for the task panes that open when the system is started. System-

controlled task panes are displayed after these startup task panes.

» Minimize Axiom Assistant

By default, the Axiom Assistant area is maximized when you first start Axiom. You can minimize this area
to gain more screen space while working on a file. Axiom displays the area as a thin strip along the left-
hand side of the application when minimized.
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You can expand the Axiom Assistant area to perform a task, and then minimize it when you are finished.
* To minimize the Axiom Assistant pane, click * in the header.

» To expand the Axiom Assistant pane, click * in the collapsed header, or click on one of the task
pane tabs.

Axiom remembers the state of the Axiom Assistant (minimized or expanded) when you exit the
application and appliesy that state the next time you open Axiom on the same machine.

It is not possible to completely hide the Axiom Assistant area when task panes are open; however, if no
task panes are open, the Axiom Assistant area is automatically hidden (and is automatically displayed
again when a task pane is opened).

» Opening task panes

In most cases, task panes open automatically—you do not need to manually open them.

e Certain task panes are configured to open automatically when Axiom is started, such as the
Explorer task pane. These task panes are considered to global task panes that you use at any time
while you work in the system.

e Other context-sensitive task panes open only when using certain features. For example, the File
Processing task pane is only displayed when you open a file that is enabled for File Processing.
You do not need to manually open the task pane because it is available when it is relevant (and
assuming that you have security permissions to view it).

If you have access to the Task Panes Library to open certain custom task panes, you can open a task
pane by double-clicking it in the Explorer task pane or the Axiom Explorer dialog. Alternatively, you can
use one of your startup task panes to open other task panes.

For example, you might have access to a Monthly Reporting task pane that details the steps to run
monthly reports, and links to those reports. You don't need this task pane to be open at all times;
instead, you only need it when you are ready to process your monthly reports. You could open the task
pane as needed from the Task Panes Library or from another custom task pane to which it links.

» Closing task panes

You cannot close most task panes manually. They are either are global task panes that always apply or
they are context-sensitive task panes that close automatically when the associated file or feature is
closed. You can minimize the Axiom Assistant area to hide all task panes and gain more screen space for
your open files.

If a task pane is closeable, you can close it by clicking the X icon on the side-tab for the task pane. If this
icon is not present, the task pane cannot be closed. Typically, only task panes that you open manually
can be closed manually, but in some cases. you may also be able to close task panes that open on
startup.
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» Using task panes in the Axiom Excel Client

When using the Axiom Excel Client, each file opens within its own window, and each window maintains
its own set of ribbon tabs and task panes. As you switch windows, the set of task panes in each window
may be different. For example:
e |If you manually opened a task pane in one window, that task pane is only present in that window.
It is not be present in other windows.

e The currently active task pane is managed independently for each window, so the active task
pane may change as you change windows. This behavior occurs when using the Axiom Windows
Client, if you switch between files with different default task pane associations. However, in the
Axiom Excel Client this behavior may also happen when switching between files with the same
default task pane associations.

e The current state of task panes is managed independently for each window. For example, if you
expand the Reports Library in the Explorer task pane in one window, that expansion is not
present if you switch to a different window.

Exploring files using the Explorer task pane

Use the Explorer task pane in the Desktop Client to quickly access your favorites, recent items, and all
Axiom files (and other assets) that you have rights to access.

The Explorer task pane is a streamlined version of the Axiom Explorer dialog. Most files and features
available in Axiom Explorer are also available in the task pane, depending on your security permissions.

The Explorer task pane is available in the Axiom Assistant area. To view the Explorer task pane, click the
Explorer tab along the left-hand side of the Axiom Assistant area.

NOTE: The Explorer task pane is provided by default, but it may be disabled in your system,

restricted to certain users, or customized. If you are an administrator and you want to configure the
availability of the Explorer task pane, see the System Administration Guide.

The Explorer task pane is organized into sections. You can collapse and expand each section by clicking
the arrow button in the right-hand side of the section header.
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Explorer Section Description

My Files Contains the following:

¢ Favorites: Your personal list of favorites. For more information on saving
and managing favorites, see Managing favorites.

¢ Recent: A list of your recently-opened items. This list displays the last 15
items that you opened. You can clear the list by right-clicking Recent and
selecting Clear History.

¢ My Documents: A personal folder within the Axiom file system where you
can save documents. Only administrators and users with the User
Documents Folder Access security permission have access to this feature.

NOTE: If a red arrow icon is displayed next to an item in Favorites or Recent,
the item the shortcut points to was deleted. Moving or renaming an item
does not break a shortcut because files are tracked using the document ID.

File Groups Contains the file groups to which you have access.

End users can open plan files from this area. Administrators and other users
with special feature permissions can manage file groups from this area.

By default, file groups are displayed in categories. If you do not use
categories or you want to change the view to display file groups, right-click
the File Groups header.

Libraries Contains the Axiom libraries and files to which you have access. You may
have access to one or more of the following:
¢ Reports Library
¢ Table Library
¢ Data Diagrams Library
¢ Filter Library
e Task Panes Library
¢ Ribbon Tabs Library
¢ Process Definition Library
e Scheduler Jobs Library
¢ Imports Library
e Exports Library.

Most end users only have access to the Reports Library.

Axiom System Contains Axiom system files. Only administrators have access to this area.
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Commenting on documents using the Message Stream task pane

When viewing a spreadsheet Axiom file within the Desktop Client, you can view comments that other
users have made about the document and also make comments about the document. New comments
are stored in the message stream for that document so that all other users who access the document
can see the comment. Additionally, you can tag other users in the comment so that the tagged users are
notified about the comment.

You can view and add comments using the Message Stream task pane. This is a system-controlled task
pane that automatically opens for eligible documents.

NOTES:
¢ The message stream is only available for documents where it has been enabled.

e The message stream is also available for Axiom forms that open within the Desktop Client,

using the Message Stream panel. This panel is accessible from the task bar across the top of
the form.

» Viewing the message stream

To view the message stream for the current document, click the Message Stream tab to display the task
pane in the Axiom Assistant sidebar. This task pane shows all comments that were made about the
document.

< Axiom Assistant A| Home =] [BGT20] 40000
I |
+ Add Comment e 40000 Los Angeles - Store 34
g Current View: Standard view
=
i | Travel budget looks goad to me, Account
w Statistics
§ 95000 Volumes
= | @Wendy Hunter Please look at the travel budget. Total Statistics
= > Revenue
3
= 4000 Revenue
)
%Ju <o hdd a new Ravenie rogw s 2
] Total Revenue
3
S Marketing

Example message stream

Comments are displayed in the order they were made, with the most recent comment at the top of the
panel. Each comment shows when the comment was made and the user who made it.
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To view the full text and details of a comment, hover your cursor over the comment so that the >
symbol displays to the right of the comment. Click the symbol to open a separate Comment Details
dialog with the full comment text.

After the message stream is loaded for the current document, it is only updated automatically after you
add a new comment. If necessary, you can manually refresh the task pane to see if other users made
comments during the current file session.

Comments are stored for the life of the document and cannot be deleted.

» Adding a comment

To add a comment, click Add Comment at the top of the Message Stream task pane. In the Add
Comment dialog, you can define an optional title for the comment, and then define the comment text.
You can use basic text formatting such as bold, italic, and underline.

A | Add Comment =

Add Comment

Title
optional
Message
B I U Tag user v

[@Wendy Hunter Please take a look at the Travel budget.

If desired, you can "tag" one or more users in the comment, so that those users are notified about the
comment. Any user tagged in the comment will receive an email that contains the content of the
comment and a link to the document. To tag a user, use the Tag user box to find a user and insert the
tag. You can type into the box to find a specific user, or select a user from the drop-down list. When you
click on a user name in the list, a tag will be inserted at the current cursor point in the comment text.
The tag displays as @FirstName LastName.
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When you click Post, the comment is saved to the message stream, and any tagged users will be
notified.

NOTES:
e All users with access to the document can see comments posted to the message stream. Any
comments made should be appropriate for the entire document audience. Do not post any
sensitive information to the message stream.

¢ Adding a comment automatically subscribes you to the document's message stream, and
tagging a user automatically subscribes that user to the document's message stream.

» Ongoing notifications (subscriptions)

If you have made a comment in a document's message stream, or if you have been tagged in a
comment, you are now subscribed to that document's message stream. Whenever a new comment is
made to that document's message stream, you will receive a notification in the Notifications task pane.

The notification details the user who made the comment and when it was made, the text of the
comment, and a link to open the file.

Currently it is not possible to unsubscribe from a document's message stream once you have been
subscribed.

Viewing and completing process tasks using the Process task pane

Use the Process Management feature to manage and track any Axiom-related process. A process is a
series of defined steps that represent the tasks to be completed. If you are the assigned owner of a step
in a process, it is your responsibility to perform the necessary task and mark the step as complete by the
specified due date.

The Process task pane appears in the Desktop Client automatically when you are the owner of an active
step in a process. The task pane displays one or more processes in which you have active tasks. The
process summary displays the process name and the number of active tasks you have in the process.

NOTE: The Process task pane is available by default, but it may be disabled or customized in your
system. If you are an administrator and you want to configure the availability of the Process task
pane, see the System Administration Guide.

To view your active tasks in a process, click the arrow on the left to expand the process (or double-click
the process summary). Your active tasks) are listed underneath. For each task, you can view the step
name, the due date, and any additional details about the step. The following screenshot shows an
example Process task pane with an active task:
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Using the Process task pane, you can do the following:

e Open associated files and features: Some tasks may have a link to an associated file or feature to
help you perform the task. Other tasks do not have these links. If no link is present, you must
manually navigate to any file or feature that is required to perform the task.

e Complete the step: When you finish your task, you must mark the step as complete. In most
cases you do this by clicking Mark step as complete.

A special type of step exists and is known as an approval step. In this case, you must indicate
whether you approve the process to continue by clicking either Approve or Reject. Approve
means that the process moves to the next step and Reject means that the process returns to a
prior step.

¢ View the entire process: By default, only your active step is shown in the task pane. In some
cases, you may have the option to view all steps in the process to see how your active step
relates to the overall process. If this option is present in the task pane, click Show process view to
view all steps in the process, including previously completed steps and steps to be performed in
the future. This view is informational only; you cannot complete steps in Process View. To return
to Task View, click Show task view. Process View is available only to step owners if the process
has been configured to allow access to it.

» Step types

Each step listed in the Process task pane has an icon that indicates what type of step it is.

Icon Step Type Description
Ea Approval Requires you to approve the process to continue to the next step,

or reject the process to return it to a prior step.

B Edit Plan File Requires you to work on a plan file.
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Icon Step Type Description

=] File Group Requires you to perform a task on a file group.

Y Generic Requires you to perform any kind of task.

s Import Requires you to perform a task on an import.

Ea Multiple For multiple approvals, all sub-steps that follow can be performed
Approvals in any order instead of sequentially. You may be responsible for

one or more sub-steps of the subprocess.

NOTE: Axiom only displays this icon in Process View, where you can
view the parent step as well as all sub-steps. Parent steps are not
displayed in Task View and only currently active sub-steps are

displayed.
& Parallel For parallel processes, all sub-steps that follow can be performed in
Subprocess any order instead of sequentially. You may be responsible for one

or more sub-steps of the subprocess.

NOTE: Axiom only displays this icon in Process View, where you can
see the parent step as well as all sub-steps. Parent steps are not
displayed in Task View; only currently active sub-steps are

displayed.
E| Report Requires you to perform a task on a report.
R Scheduler Automatically runs a designated Scheduler job. The job status

appears in the task pane for your information only. Generally, you
do not need to do anything to complete this step, as all job
processing and step completion occurs automatically.

552} Table Requires you to perform a task on a table.

With the exception of the Scheduler step type, Axiom does not automate any of the tasks. Although a
file or feature may be associated with a step, you decide whether to use that file or feature to perform
the task. Other tasks may not be associated with any file or feature, and you must decide how to
perform the task.

If you are unclear about what needs to be done to perform the task, review the step description (in the
step tooltip) and contact your system administrator if you have any further questions.

» Completing steps

To complete a step, click Mark step as complete (or click Approve / Reject if the step is an approval
step), which opens the Process Action dialog.
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The diagram at the top of the dialog shows the current step, the next step, and the previous step (when
rejecting only). If you complete or approve the current step, the process moves forward to the next
step. If you reject the current step, the process moves back to a prior step.

You can enter a comment into the Comment box (up to 1000 characters) and save it in the process

history. In most cases, it is also included in the notification to the next step owner (if notifications are
enabled).

A | Process Action >

& Mark process step as completed in process 'Monthly Updates',

Current Step Mext Step
& Import monthly actuals =] Run tie out report
& Jane Doe (jdoe) - Wendy Hunter
Comment Any comment will be stored with the process and included in notifications to the next step owner

1000 characters remaining

QK | | Cancel
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NOTES:

¢ [f the step you are completing is a child approval step of a multiple approvals step, the next
step is the top-level step that comes after the multiple approvals step. However, other active
child approval steps might need to be completed before the process moves to that next top-
level step. If you approve the step and enter a comment, the comment is included in the
notification to the next step owner once all of the child steps are complete.

¢ |f the step you are rejecting allows the step owner to select the return step, the Previous Step
section displays a drop-down list of the available return steps. You must select the step to
which the plan file should return=.

 |f the step you are completing is part of a parallel subprocess, only the current step is
displayed at the top of the dialog. Parallel steps can be completed in any order and
completing the current step does not necessarily move the process to the next step, which
happens only when all parallel steps are complete. In this situation, any comment is only
saved in the process history and is not included in an email to the next step owner.

¢ |f the step you are completing is a File Group step that involved cloning a file group, and the
new file group is referenced by subsequent steps, you must specify the name of the file group
that was created as a result of the step. Axiom attempts to guess the correct file group. If the
guess is not correct, you can use the drop-down list in the step completion dialog to specify
the correct file group. The dialog only lists clones of the target file group for the step.

e If you are the assigned owner of a Scheduler Process Step, by default, you do not need to do
anything to complete the step—it is completed automatically if the Scheduler job processes
without error. However, if the job experiences errors, you can either Restart scheduled job
(assuming that the issue that caused the error has been resolved) or Mark step as complete
(assuming that the job does not need to be run again to consider the step as completed).

If the step you completed was your only active task, the Process task pane will be empty for the
remainder of the current session, and will not open the next time you log in (unless you have been
assigned a new active task). The task pane remains open if you have other active tasks in this process or
another process, or if you are an administrator. The Process task pane is available to administrators as
long as any processes are active.

» Completing steps for multiple plan files

If the process is a plan file process, the steps in the process are performed for each individual plan file in
the file group. In this case, you may be responsible for completing the task for multiple plan files.

If you are responsible for multiple plan files, those files are listed with check boxes in the Process Action
dialog. You can select one or more check boxes to complete the step for those plan files.
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A | Process Action >

r‘?g Mark process step as completed in process 'Budget Process'.

Current Step MNext Step
D Initial Submission __.__. Management Approval
& Jane Doe & Wendy Hunter
Complete step for: (1 of 2 selected) Select Al Clear All

Dept 40000 (Los Angeles - Store 34)
] Dept 40500 (West Coast Distribution)

Comment Any comment will be stored with the process and included in notifications to the next step owner.

Travel budget is higher than expected due to sales conference,

038 characters remaining

QK | | Cancel

» Administrator features

If you are an administrator, the task pane shows all active processes for which you have an active task,
as well as all active processes for which you are the process owner. You have the option to change the
view to show all active processes. At the top of the task pane, use the Show all processes toggle to see
all active processes. To return to viewing only your processes, click Show my processes only.

< Axiom Assistant

Current Processes '@
?33 Showing my processes only Show all processes
B
S .

~ ) Budget Process View status
5 You have one active task in this process
[T
a : .
2 || Process view Show task view
&

1 - Initial Submission

= 119 active plan files
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Administrators and process owners can also perform the following actions in the task pane:
e Click View status to view the Process Status dialog for the process.
¢ Right-click a process and select Stop Process to stop the process.

¢ Toggle between Show process view and Show task view. However, if you do not currently have
any active tasks in the process, you can only use Process View.

Viewing notifications using the Notifications task pane

Axiom displays notifications in the Notifications task pane. This is a system-controlled task pane that is
always available in the Desktop Client if you have notifications. Click the Notifications tab in the Axiom
Assistant area to view the task pane.

¢ Axiom Assistant

My Matifications

» 1, Expense variance
alert for UK

Explorer

w Iy Revenue variance alert
for US East

Revenue variance is negative, please
review,

Dpen

Workflow

» /I, Revenue variance
alert for US Central

Notifications

Example Notifications task pane

If you have unread notifications when you first log in or you receive new notifications during a current
session, the Notifications tab flashes orange and remains that color until you click the tab. Unread
notifications appear in bold text. After a notification has been read, the bolding is removed.

Notifications can come from the following sources:

¢ Alert notifications. Your system administrators and other power users may have set up alerts to
monitor certain alertable conditions and then notify specified users.

e Process management notifications. These notifications result from active processes in process
management, such as to inform you that you have a new task in the process.

¢ Message stream notifications. If you have subscribed to a document's message stream, you will
be notified of any new comments made about that document.
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e Axiom system processes such as Process Plan Files. If you have triggered certain system
processes, Axiom will notify you when the process is completed or when errors occur.

e Scheduler jobs. If you have run a Scheduler job manually and that job is configured to send
notifications, you will be notified when the job completes or errors (depending on the notification
configuration).

NOTES:

¢ The Notifications task pane is a system-controlled task pane; you cannot hide or show this
task pane manually. The Notifications task pane always appears on startup if you have any
active notifications (read or unread). Otherwise, Axiom does not display it. If you receive a
new notification during a session and the task pane is not already open, the task pane opens.

¢ All notifications displayed in the Notifications task pane are also available in the Notifications
panel of the Axiom Web Client. Both areas read from the same source of notifications and
edit the same source. If you read a notification in one area or delete a notification from one
area, the other area reflects these changes.

» Reviewing notifications

Within the task pane, notifications are listed in the order they were created, with the newest
notifications at the top. Each notification displays a severity icon and an alert title, as well as the age of
the notification. The following severity icons include:

- @ Info
e % Warning
. ! Error

To read the notification text, double-click the notification to expand it. The text provides you with more
information about the notification and why you are receiving it. You can double-click the notification
again to collapse it.

If the notification is from an alert, the alert creator may have specified a document for you to view
additional information about the alert condition. An Open link appears underneath the message text
when you expand the notification. Click this link to open the associated document.

» Notification actions
You can select one or more notifications, and then right-click to perform the following additional
actions:

e Mark Read: Mark the selected notifications as read.

e Mark Unread: Mark the selected notifications as unread.

e GoTo Alert Definition: Open the source document for the alert if you have permission to access
the file. You are taken directly to the alert definition that generated the notification.
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e Delete: Remove the selected notifications from the pane. After a notification has been removed
from the pane, you cannot undo this action.

Notifications will remain in the list until you remove them, or until they are deleted by the system purge
job. By default, the system purge job deletes alerts and notifications older than 60 days.

Managing favorites

You can save Axiom files and other items as favorites for quick access to commonly used items. In the
Desktop Client, your favorites list is available in the following locations:

e The Explorer task pane in the Axiom Assistant area

e The Axiom Explorer dialog (if you have permission to access this dialog)

< Axiom Assistant

My Files
~ 3¢ Favorites
@j Incame Statement By Maonth
(3] 41000
@j Meonthly Package Cellect

7| Recent

Explorer

33
-

BES

When an item is saved to favorites, you can open the item by double-clicking it, or you can right-click it
to access any other commands that are available on the item in its native area. For example, if you have
rights to the Table Library and you save a table as a favorite, you can right-click the table favorite and
perform actions such as editing the table structure.

If an item that a favorite points to is deleted, the favorite becomes invalid and a red arrow icon appears
next to it. If you attempt to open an invalid favorite, a message box informs you that the item has been

deleted and asks prompts whether to delete the favorite. If a file is moved or renamed within the Axiom
file system, but it retains the same document ID, the shortcut is not be broken.

» Saving and deleting favorites
You can save an item as a favorite in one of the following ways:

* |nthe Explorer task pane and the Axiom Explorer dialog, right-click an item and select Add to
Favorites.

e When a file is open, right-click the file tab and select Add to Favorites.

The item is saved as a favorite and is now displayed in your Favorites list. If the file was open when you
saved it as a favorite, it displays the file tab name. If needed, you can change the display name by
editing the shortcut properties for the favorite.
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TIP: If you open a table using Open Table in Spreadsheet, and then save the open table as a favorite
(using the file tabs), the settings you used are automatically saved as part of the favorite in the
shortcut properties. You may want to rename the favorite to indicate the specific settings (for
example: GL2023 - Filtered for North Region).

NOTE: If a web-enabled file is saved as a favorite in the Desktop Client, that favorite is also displayed
in the Web Client, which includes Axiom forms and web reports. All other types of favorites are not
displayed in the Web Client.

To delete a favorite, right-click the item and then select Delete.

» Organizing favorites

You can create sub-folders in the Favorites area to organize favorites by folder. To create a new folder,
right-click Favorites and select New Folder.

By default, favorites are displayed in the order that they were added (new favorites are added to the
bottom of the list). You can drag individual favorites to a new location to change the order. Sub-folders
cannot be reordered—Axiom always displays them in alphabetical order.

To rename a favorite, right-click the item, and then select Rename. The name becomes editable, and
you can type a new name.

» Shortcut properties

You can edit the shortcut properties for a favorite. Right-click the favorite and select Shortcut
Properties. In this dialog, you can edit the shortcut name, change the shortcut target, and define certain
shortcut properties.

The available shortcut properties vary by file type. For example, you can configure a report favorite to
always open as read-only or automatically apply a Quick Filter when opening.

» Using web favorites in the Desktop Client

If you save a favorite in the Web Client, Axiom displays that favorite in the Desktop Client favorites list.
You can double-click the web favorite to open it in the Web Client browser.

When a favorite is saved in the Web Client, it is stored as a URL instead of a document shortcut. If the

target of the favorite is later deleted, the favorite does not show as invalid in the Desktop Client. If you
try to use the favorite, you are informed that the document or page cannot be found. In this case, you
must manually delete the favorite.
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Opening recent files

Axiom maintains a list of your recently opened files in the Desktop Client. You can use this list for quick
access to recent files.

The recent file list is located in the My Files section of the Explorer task pane and Axiom Explorer. You
can double-click files to open them, or right-click to access the context menu for the file type. Recent
files are listed using the file tab name that they were opened with, which may or may not be the same
as the file name.

The list displays the last 15 files that you recently opened. Note the following:
¢ |f you want to clear the list, right-click Recent and select Clear History.

e |If you want to continue to have quick access to a recent file, you can add it to your favorites.
Right-click the file and select Add to favorites.

e |f the icon next to a file name is a red arrow, this means that the file has been moved or deleted
since you accessed it, so it can no longer be opened from the recent file list.

In the Axiom Windows Client only, recent files can also be accessed from the File menu. In the Axiom
Excel Client, although your recent files are tracked in File > Recent, those links point to the temporary
versions of the file stored on your local drive, not the source versions of the files stored in the Axiom
database. Therefore, Excel's recent file list cannot be used to open Axiom files.

Changing your Axiom password

If your authentication method is Axiom Prompt, you can change your password as needed using the
Desktop Client. This feature does not apply to users who use any other authentication method (such as
Windows User Authentication), because those passwords are controlled externally from Axiom.

To change your password:

1. Onthe Axiom tab, in the Help group, click Help > Change Password.

NOTE: In systems with installed products, this feature may be located on the Main or Admin
tab.

This command is only available to Axiom Prompt users.

2. Inthe Set Password dialog, enter your current password, and then enter and confirm your new
password.

If password rules are enforced, your password must meet the rules. A validation message informs
you of the rules, if necessary. Alternatively, you can click Generate Password to auto-generate a
password that meets the rules. If you do this, write downe the generated password, because you
will not have another opportunity to see it. If you do not note the password and cannot log in
later, an administrator must reset your password.
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3. Click OK.

Your password is now changed. You will need to use this new password the next time that you log in.

Closing Axiom

When you close Axiom, you are prompted to save any changes.

To close the Desktop Client:
e (Click Close Axiom Software in the Exit group of the Axiom tab.

NOTE: In systems with installed products, Close Axiom Software may be located on the Main
or Admin tab.

You can also close the application by clicking the X in the top right-hand corner of the application
window.

If you use the Axiom Excel Client, no option is available to close Axiom, so you can leave the current
Microsoft Excel session open. You do not need to close Axiom to work on a regular Excel file. You can
open regular Excel files within Axiom or open a second Excel session.
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Using Plan Files

Use plan files to develop planning data and save that data to the database. This section explains the
basic concepts behind plan files and how to use them in the Desktop Client.

This section is intended for end-users who work with existing plan files to develop and review plans. If
you have rights to administer file groups and their components, see the File Group Administration Guide
and the Axiom File Setup Guide.

In addition to the plan-specific functionality, you can use standard Axiom file features and tools. Plan
files use the same functionality as other Axiom files to perform actions such as changing views or
navigating to file bookmarks. For more information, see Using Axiom File Features.

About plan files

Using plan files, you can develop planning data for your responsibility areas and save that data to the

database.
Department Axdom
Managers Plan Files Database Reports
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Example data flow for planning data

Each plan file is created as a copy of an assigned template. After the plan file is created, it is populated
with data and calculations that are unique to the specific plan code. Depending on the design of the plan
file, you can perform activities such as inputting data, adding comments, and inserting new rows as
needed. When you save, data from the plan file is saved to the applicable tables in the database, where
you can then use the data in reports.
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Plan files are associated with a file group, which is a set of files that support a specific planning effort.
You may have access to multiple file groups.

Your organization may use file groups to manage multiple planning processes (for example, a Budget file
group and a Forecast file group), or each file group may represent a specific planning cycle (for example,
the 2023 Budget file group). If you have questions regarding the purpose of each file group, contact your
system administrator.

Typically, a plan file is available for each plan code within the designated planning dimension for the file
group. For example, budgets are typically created at a department level, but forecasts are often created
at a divisional or regional level. The Budget file group would have a plan file for each department, and
the Forecast file group would have a plan file for each division. However, planning can be performed at
any level.

» Plan file structure
Plan files may be spreadsheet-based or browser-based:

e Spreadsheet-based plan files are Microsoft Excel spreadsheets that are managed and enhanced
by Axiom. You can use spreadsheet features within the plan file, and within the limits of the sheet
protections applied to the plan file. Plan files can have multiple sheets. For example, a plan file
might have an Instructions sheet, a Budget sheet, and a Payroll sheet.

e Browser-based plan files are interactive web pages that meet a specific planning need. You can
access these plan files within the Axiom Windows Client or within your web browser (the Web
Client). These plan files are typically organized into multiple tabs so that you can move between
different areas of the plan file by clicking the tabs. Browser-based plan files are created by using a
special type of Axiom file called an Axiom form.

Plan files can vary from system to system. If you have any questions about the contents of a plan file,
contact your system administrator.

Generally, the information in this guide assumes that you use spreadsheet-based plan files within the
Axiom Excel Client or the Axiom Windows Client. Spreadsheet-based plan files use a standard set of
features to perform actions such as inserting new rows, changing views, and navigating to different
areas of the plan file. Browser-based plan files support greater customization of the user interface, so
that the way in which users interact with the plan file can differ greatly, depending on the file design.

» Calc method libraries

Each sheet in your plan file may have access to a calc method library. Calc method libraries contain sets
of predefined rows that define the formatting and calculations for rows in your plan. You can use these
calc method libraries to insert new rows into your pla or change the calculations on existing rows of your
plan. See Adding or changing rows in a plan file.
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» Plan file access

You have been granted rights to access certain file groups and certain plan files within those file groups.
You can open those plan files according to the level of access you have been assigned in Security (for
example, read-only or read/write).

Plan files can also be part of a plan file process. In this case, the planning cycle has a defined set of steps,
and each plan file has a designated owner for each step. If you are assigned as an owner, your
responsibility is to complete the current task in the process, which could include editing the plan file or
reviewing it, depending on the current step. Axiom may elevate your access rights to the plan file so that
you can complete this task. For example, if you typically have read-only access to plan files, but you are
the assigned owner of a plan file in an edit step, you are granted temporary edit rights to complete the
task.

Opening a plan file
In the Desktop Client, plan files are accessed from the File Groups group on the Axiom tab or in the
Explorer task pane. Your security settings determine to which file groups you have access, and which
plan files you can access within the file group. Your access rights to each plan file (read-only or
read/write) are determined by a combination of your security settings and whether you are the current
owner of the plan file in an active plan file process.

NOTE: The names of the file groups and how they are presented to you is determined by your
organization. Although the default presentation is on the File Groups group of the Axiom tab, your
organization may decide to customize the group name or location or present file groups in a custom
ribbon tab or task pane. Plan files may also be accessible via the Process task pane. Contact your
system administrator if you have any questions about how to access your plan files.

To open a plan file:
1. On the Axiom tab, in the File Groups group, click the name of the file group that you want to
work with. The following example shows some example file group buttons:

AXIONM

V=) Budget 2017
E Capital Reguests
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If you have access to any file group administration features, clicking the file group button displays
a menu with your options. In this case, you must click Open Plan Files to open a plan file. If you
do not have access to any file group administration features, clicking the file group button
automatically launches the Open Plan Files dialog.

File groups can be organized into categories. In this case, click the category name to open a sub-
menu with the list of file groups in the category, and then click the applicable file group name.

TIP: You can also open plan files from the file groups listed in the Explorer task pane.

2. Inthe Open Plan Files dialog, select the file that you want to open, and then click OK.

This dialog lists all plan files available to you based on your Security settings. If you have
previously opened a plan file within this session, that plan file is selected by default when you
enter the dialog (unless the dialog displays plan files in groupings, in which case previous
selections are not retained).

Use the search box to quickly find a specific plan file. The file group administrator determines
which plan file properties are included in this search, but by default, the plan code and
description are searchable. You can also sort and filter the list using standard Axiom grid
functionality.

TIP: If you have read/write permissions to a file but want to open it as read-only to prevent
locking the file from other users, right-click your selection, and then select Open Read Only.

If the dialog is empty, you do not have access to any plan files in the file group or the plan files
have not yet been created for the plan codes to which you have rights.

If the file is opened as read-only, the text (R/0) appears in the file tab. Read-only plan files cannot be
saved.

NOTE: If another user has the plan file open with read/write permissions, the file is opened as read-
only, regardless of your security permissions.

If the plan file is form-enabled, it opens as a web form within the current client (Windows Client only) or
in the Web Client browser. When using Axiom forms, the form is always opened as read-only, and any
save processes are only for saving data to the database. The functionality in an Axiom form is solely
dependent on how the form is configured. If you have questions about the use and features of a web-
enabled form, contact your system administrator.

Advanced options
The following advanced options in this dialog are generally only available to administrators:

e To open a plan file without refreshing Axiom queries that are configured to refresh on open,
right-click the file, and then select Open Without Refresh. Generally, you should only do this if
you open the file for troubleshooting purposes or you want to edit its configuration.
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e If no plan files were created for this file group, and you have rights to create plan files, a link
appears in the blank plan file list: Create Plan Files for File Group. You can click this link to open
the Create Plan Files dialog.

e To view plan codes that do not yet have a plan file, select Show Plan Files that have not been
created. This option is for reference only; you cannot create individual plan files from this dialog.

¢ [f the plan file is form-enabled and you want to open it as the source spreadsheet file instead of
as the web form, select Open as Spreadsheet. This option is available to all users.

Creating a plan file

Some file groups may be set up so that users can create plan files on demand. Typically, this
configuration is used for planning processes where the list of projects or initiatives to be planned for is
not known in advance, such as capital project planning or strategic planning. Instead of planning based
on a predefined list of items (such as budgeting based on departments), users can create plan files as
they are needed.

NOTE: The ability to create a plan file on-demand is only available if the file group meets certain
requirements and the feature has been enabled in the file group properties. For more information
on using this feature with a file group, see the File Group Administration Guide. For other file groups,
end users do not create plan files; instead, an administrator creates the plan files using the Create
Plan Files utility.

This topic discusses the default method of creating new on-demand plan files in the Desktop Client. Your
system may be configured to create new plan files in different ways, such as from a custom task pane, or
using an Axiom form.

To create a plan file on demand:
1. On the Axiom tab, in the File Group group, click the button for the file group where you want to
create a new plan file.
2. To create the plan file, you can base it on the plan file template or clone an existing plan file. Use
the commands in the top right-hand corner of the dialog:
e To create a new plan file based on the template, click the plus icon .

The name of this command is configurable for the file group. For example, the command
may say Create plan file, or Create new project, or Add strategic initiative.

* To clone an existing plan file to create a new plan file, select the plan file that you want to
clone, and then click Clone selected item.
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A | Open Plan Files 7 X

. .
? Open Plan Files for Capital Requests

<type here to filter list> + Add New Request ER Clone selected item

CapitallD E Description E Dept E CapRequestCode E Locked By E Last Modified By E

4 MNew Machinery 51500 CapReq51500-4-2016 whunter
5 Equipment Maintenance 44500 CapReq44500-5-2016 whunter
6 New Warehouse 43500 CapReq43500-6-2016 whunter

These commands are not available for file groups where the on-demand feature has not been
enabled.

3. Before the plan file is created, you may be prompted to select certain values relating to your new
plan file, such as specifying a department. Complete the inputs, and then click OK.

The new plan file is created and opens in Axiom. You can now complete any necessary inputs and
changes, and then click Save to save it.

If you cloned an existing plan file, any inputs in the existing plan file are also included in the new file. You
may need to change these entries for the new file.

NOTES:
¢ If you do not have the necessary security permissions to create new plan files in an on-
demand file group, then Axiom does not display options to create new or clone existing in the
dialog.
¢ The clone existing functionality can be disabled at the file group level, in which case, the
option is not displayed in the dialog.

Editing a plan file
When you open a plan file, the level of edit rights depends on the combination of your security settings
and whether you are the current owner of the plan file in an active plan file process. For example, you

may typically have read-only access to the plan file, but when you are the step owner for an Edit Plan
File task in a plan file process, you are temporarily granted read/write access.

If you have edit rights to a plan file, note the following:

¢ In plan files, editable cells are shaded or otherwise marked as available for edit. If a cell is
editable, you can input values directly, or use Excel formulas to result in a value. All other areas of
the sheet are typically protected and cannot be changed.

e Some cells may use Data Validation to present a list of choices. In this case, you can use the drop-
down list to select an option.
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e Depending on your security rights, you may be able to add new rows to the plan or change the
calculations on existing rows. For more information, see Adding or changing rows in a plan file.

e If your plan files support it, you may be able to double-click a row of the plan to bring up an input
form for that row. The input form contains key settings for the row that are editable.

Plan file design is flexible to meet the needs of your organization. If you have questions about the design
of your plan files, contact your Axiom system administrator.

When you have finished making edits to the plan file, click Save to save the changes and to save your
data to the database. For more information, see Saving a plan file.

Adding or changing rows in a plan file

Calc method libraries store sets of predefined calculation methods that define the formatting and
formulas for rows in your plan file. You can use calc methods to:

e Add a new row (or rows) to your plan.
When plan files are created, they may only be populated with accounts that have historical data.
You may need to use calc methods to add an account to your plan if you did not plan for that

account last year. You can also use calc methods to add new items to your plan, such as new
employees or new capital items.

¢ Change the calculations used in an existing row in your plan.

Using the calc method change option, you can change the calculations on existing rows of your
plan by applying a different calc method to that row. For example, imagine that the default
calculation for an account is to spread a total amount evenly across months, but for your plan
code, it is more appropriate to use a monthly statistic to spread the total.

Calc methods can be used even when the sheet is protected.

Adding rows to a plan file
You can insert new rows into your plan file using calc methods. A calc method is one or more predefined
rows that define the formatting and formulas to be applied to a row. For example, you may need to:

e Add an account that is not currently in the plan file.

¢ Add a new employee.

e Add additional detail lines, if you are planning for certain accounts at the detail level.

After a calc method is inserted, you need to complete the new rows with the appropriate information.
For example, you may need to enter an account number, or input plan values. The calc method may use
a form to help you complete some of these inputs.
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You can only insert calc methods if you have the appropriate security permissions. The ability to insert
calc methods is controlled on a per file group basis, using the Allow Calc Method Insert permission.
Additionally, administrators and users with the Manage Calc Methods permission can insert calc
methods.

Additionally, most plan files are set up to use calc method controls. If you have the necessary security
permissions to insert calc methods, these controls further specify where you can insert calc methods
and which calc methods you can use at each location.

You can add a new row to a plan file using several different methods. The methods available to you
depend on how your plan files were set up by your administrator:

e You can use custom insertion points to automatically add new rows to the appropriate locations
throughout the plan file.
e You can double-click designated rows within a sheet to add new rows at that location.

¢ If the plan file does not use either of the above methods, or if you are a calc method
administrator who can add rows anywhere in the file, you can add new rows manually.

» Adding a row using a custom insertion point

Plan files may be set up with custom insertion points. These points guide you to the appropriate places
to add new rows to a plan file. Custom insertion points are available on the Add Row(s) > Custom
Inserts menu.

The two types of custom insertion points include dynamic and static. Plan files may use only dynamic
insertion points, only static insertion points, or a combination of both.

e When using a dynamic insertion point, you select the item to add to the plan file (such as an
account), and then the insertion controls dynamically determine where the account should be
added. If the account already exists in the file, you are taken to the relevant row.

e When using a static insertion point, you select from one or more specific areas in the plan file
that are enabled for insertion, and then add the new row in that selected location.

The Custom Inserts menu shows all insertion points defined within the file (not just for the active sheet).
When you select an insertion point, you may be taken to another sheet in the file.

The Custom Inserts menu is only available if you have the appropriate security permissions to insert calc
methods.

To insert new rows using a custom insertion point:

1. Onthe Axiom tab, in the File Options group, click Add Row(s). Then, select the applicable
insertion point from the Custom Inserts menu.

TIP: You can also access this menu by right-clicking anywhere in a plan file (Calc Methods >
Custom Insert).
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Dynamic insertion points are single items on the menu. For example, there might be a dynamic
insertion point named Update an account:

5= Add Row(s) ~

Custom Inserts
|_'] Update an account

Static insertion points are organized into sub-menus. For example, there might be sub-menu
named Add a new employee, which contains two insertion points: Hourly and Salary.

5= Add Row(s) -
Custom Inserts

|||_| Add a new employee F Add a new employee actions on sheet Payroll |
|||_| Add a non-wage account k |_'] Hourly

|_'] Salany

2. The next step depends on whether you selected a dynamic insertion point or a static insertion
point:

e If you selected a dynamic insertion point, the Choose Value dialog opens. Select the
applicable item to add to the plan file, and then click OK. For example, the dialog may
display a list of accounts, and you would select the account to add.

If the selected item already exists in the sheet and no further calc methods can be
inserted, you return to the location of the existing item. The dynamic insertion process is

now complete. Otherwise, the dynamic insertion process determines where the selected
item can be added, and moves your cursor to that location.

If you have selected a static insertion point, your cursor moves to the location that
corresponds with the selected insertion point.

3. One of the following occurs, depending on whether multiple calc methods are eligible to be
inserted at this location:

e Multiple calc methods: If more than one calc method can be inserted at this location, the
Insert Calc Method dialog opens. Select the calc method to insert, and then click OK.
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A | Insert Calc Method(s) in sheet Budget ? *

Awvailable Calc Methods:  Details:

Detail Name Edit Months
Edit Months Group User
Fixed

Rows 1

Description | Use this calc method when you need to edit the
values for each individual month in the plan.

Number of items to insert: |1

0OK | | Cancel

Example Insert Calc Method dialog

The available calc methods are listed in the left-hand side of the dialog. When you select a
calc method name, Axiom displays the properties of that calc method in the right-hand
side of the dialog, including a description. If you are unsure of which calc method to use,
the descriptions may provide guidance.

To insert multiple instances of the calc method, edit the Number of items to insert. By
default, this field is set to 1. For example, you may need to add two new employees to a
payroll budget, and both employees use the same calc method. In this case, you set
Number of items to insert to 2. The number of items that you can insert at any time may
be limited to a certain maximum amount.

NOTE: The calc methods in this list are always limited to the calc methods allowed at
this location. If you are an administrator or a user with the Manage Calc Methods
permission, and you want to insert a different calc method at this location, you must
insert it manually.

e Single calc method: If only one calc method can be inserted at this location, that calc
method is selected automatically, and Axiom does not display the Insert Calc Method
dialog.

If this location allows you to insert multiple instances of the calc method, you are
prompted to specify the number of items to insert. Enter the number of items (up to the
specified maximum), and then click OK.
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A | |Insert *

Enter the number of items to insert (max of 3).

2

| 0K | | Cancel

4. If the selected calc method has defined variables, Axiom displays the Calc Method Variables
dialog. Enter values for the variables, and then click OK.

The values that you enter for the variables are populated in the appropriate cells when the calc
method is inserted into the sheet.

This dialog only applies if the calc method has defined variables. Otherwise, Axiom does not
display the dialog and the calc method is inserted into the sheet.

NOTES:

¢ If your plan files were configured to support double-click for calc method variables, you
can open this dialog again later by double-clicking the calc method in the sheet and
change any entries as needed. Some variables may be set up so that they are displayed
only when inserting, such as the variable for selecting an account.

¢ If you insert multiple instances of the calc method, the selected values are repeated in
each inserted calc method. In most cases, you will need to edit the calc methods after
they are inserted to select unique values for each item.

After the calc method is inserted into the sheet, you may have inputs to complete. For example, you
may need to input an annual total to be spread equally across months or according to a statistic.

» Adding a row by double-clicking

You can set up plan files to be able to add new rows by double-clicking in designated locations. These
locations are designated in the sheet using text such as: "Add new row here" or "Double-click to add a
new account." The specific text and how it appears depends on your implementation.
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41500 New York Warehouse

Current View: Standard view

Account

Overhead

5600 Rent Expense
7200 Catering
G700 Telephone
G800 Freight
8900 Supplies

9200 Depreciation and Amortization
<= Dauble-click

Total Overhead

1o add new account>=

Example plan file with a double-click "hotspot" for adding rows

To add a new row by double-clicking:

1. Double-click the cell that contains the insertion text.

2. One of the following occurs, depending on whether more than one calc method can be inserted

at this location:

e Multiple calc methods: If more than one calc method can be inserted at this location, the
Insert Calc Method dialog opens. Select the calc method to insert, and then click OK.

Available Calc Methods:

Detail

Edit Months

Fixed

A | Insert Calc Method(s) in sheet Budget ?
Details:
Name Edit Months
Group User
Rows 1

Description | Use this calc methad when you need to edit the
values for each individual month in the plan.

Number of items to insert: |1

X

ok || cancel

Example Insert Calc Method dialog
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The available calc methods are listed in the left-hand side of the dialog. When you select a
calc method name, Axiom displays the properties of that calc method in the right-hand
side of the dialog, including a description. If you are not sure which calc method to use, the
descriptions may provide guidance.

To insert multiple instances of the calc method, edit the Number of items to insert. By
default, this field is set to 1. For example, you may need to add two new employees to a
payroll budget, and both employees use the same calc method. In this case you can set
Number of items to insert to 2. The number of items that you can insert at any time may
be limited to a certain maximum amount.

NOTE: The calc methods in this list are limited to the calc methods allowed at this
location. If you are an administrator or a user with the Manage Calc Methods
permission, and you want to insert a different calc method at this location, you must
insert it manually using the Add Row(s) menu.

¢ Single calc method: If only one calc method can be inserted at this location, that calc
method is selected automatically, and the Insert Calc Method dialog is not displayed.

If this location allows you to insert multiple instances of the calc method, you are
prompted to specify the number of items to insert. Enter the number of items (up to the
specified maximum) and then click OK.

A | Insert X

Enter the number of items to insert (max of 5).

1

| 0K || Cancel |

3. If the selected calc method has defined variables, Axiom displays the Calc Method Variables
dialog. Enter values for the variables, and then click OK.

The values that you enter for the variables populate the appropriate cells when the calc method
is inserted into the sheet.

For example, the calc method may have a variable for Account. The account you select in this
dialog appears in the account column when the calc method is inserted into the sheet.

This dialog only applies if the calc method has defined variables. Otherwise, Axiom does not
display this dialog and the calc method is simply inserted into the sheet.
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NOTES:

¢ [f your plan files were configured to support double-click for calc method variables, you
can open this dialog again later by double-clicking the calc method in the sheet. You
can change any entries as needed. Some variables may be set up so that they are
displayed only when inserting, such as the variable for selecting an account.

¢ If you insert multiple instances of the calc method, the selected values are repeated in
each inserted calc method. Most likely, you will need to edit the calc methods after
they are inserted to select unique values for each item.

After the calc method is inserted into the sheet, you may have inputs to complete. For example, you
may need to input an annual total to be spread equally across months or according to a statistic.

» Adding a row manually

You can add new rows to a plan file manually by placing your cursor in the applicable area of the sheet,
and then clicking Add Row(s) > Insert Calc Method(s).

This command is available only if you have the appropriate security permissions to insert calc methods.
If you have the appropriate permissions, then the availability of the command depends on the usage of
calc method controls in the sheet:
¢ If calc method controls are used in a sheet, this option is available only for rows that are enabled
to allow calc method insertion. In almost all cases, these are the same rows that are set up with
custom insertion points, so it is easiest to use the custom inserts menu to be taken directly to
these enabled areas.

¢ [f calc method controls are not used in a sheet, you can insert calc methods anywhere in the
sheet.

Also, if no calc methods were defined for a sheet, this command is not available because no calc
methods can be inserted.

Administrators and users with the Manage Calc Methods permission can insert calc methods manually
anywhere in the sheet, regardless of whether calc method controls areused.

To insert a row manually:
1. Place your cursor in the row directly below where you want the new calc method to be inserted.

NOTE: If you insert a calc method on a row that is set up with calc method controls, the
location of the insert may be determined by the controls. By default, calc methods are
inserted above the current row, but the calc method controls may be configured to insert
below the current row.

2. Onthe Axiom tab, in the File Options group, click Add Row(s) > Insert Calc Method(s).

If this menu item is not available, one of the following circumstances applies:
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¢ No calc methods were defined for the current sheet.
e Calc method controls are currently used, and the current row is not enabled for insertion.

¢ You do not have security permissions to insert calc methods.
3. Inthe Insert Calc Method dialog, select the calc method to insert, and then click OK.

The available calc methods are listed in the left-hand side of the dialog. When you select a calc
method name, the properties of that calc method are displayed in the right-hand side of the
dialog, including a description. If you are not sure which calc method to use, the descriptions may
provide guidance.

To insert multiple instances of the calc method, edit the Number of items to insert. By default,
this field is set to 1. For example, you may need to add two new employees to a payroll budget,
and both employees use the same calc method. In this case, you can set Number of items to
insert to 2.

NOTES:

¢ [f calc method controls areused, the list of calc methods is limited to those allowed by
the insertion point. Calc method administrators always see all calc methods when
manually inserting a calc method.

¢ |f the selected calc method uses variables, and you do not want to be prompted to
enter variable values, you can clear the Prompt for calc method variables check box.
This option is displayed onlys on the dialog if the selected calc method uses variables,
and if the user is an administrator or has the Manage Calc Method permission.

4. If applicable, in the Calc Method Variables dialog, enter values for the calc method variables, and
then click OK.

If the calc method has variables, the values you enter for the variables populate the appropriate
cells when the calc method is inserted into the sheet.

For example, the calc method may have a variable for Account. The account that you select in this
dialog populates the account column when the calc method is inserted into the sheet.

This dialog only applies if the calc method has defined variables. Otherwise, Axiom does not
display this dialog and the calc method is inserted into the sheet.

NOTE: If your plan files were configured to support double-clicking for calc method variables,
you can open this dialog again later by double-clicking the calc method in the sheet. You can
change any entries as needed. Some variables may be set up so that they are displayed only
when inserting, such as the variable for selecting an account.

After the calc method is inserted into the sheet, you may have inputs to complete. For example, you
may need to input an annual total to be spread equally across months or according to a statistic.
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Changing rows in a plan file

You can change the calculations on an existing row in a plan file by overwriting it with a new calc
method. You can also use the change feature on multiple-row calc methods.

For example, your plan may have a row that requires monthly entries to calculate an annual total, and
you want to change the calculation to require a single annual entry that is spread evenly across months.

The change operation does not replace the existing row. Certain information in the row may be
retained, such as the account number and historical data, depending on how the new calc method was
configured, and whether calc method forms are used. For information on how the change operation
replaces the existing row, see Change calc method rules.

You can only change calc methods if you have the appropriate security permissions. The ability to
change calc methods is controlled on a per file group basis, using the Allow Calc Method Change

permission. Additionally, administrators and users with the Manage Calc Methods permission can
change calc methods.

Additionally, most plan files are set up to use calc method controls. These controls specify which rows
can be overwritten, and which calc methods can be used at each location.

To change a row in a plan file:

1. Place your cursor anywhere in the row (or rows) you want to change by applying a new calc
method.

If the original calc method in the sheet is a multiple-row calc method, it does not matter where
you place your cursor, so long as it in within one of the rows of the calc method.

( \
IMPORTANT: This procedure assumes that your system has enabled template validation. Use

of template validation allows Axiom to detect specific calc methods in the sheet, based on
system-generated codes. If your system does not use template validation, you must highlight
all rows of the multiple-row calc method before you can change it. If you are not sure

whether your system uses template validation, please contact your system administrator.
\\ J

2. Onthe Axiom tab, in the File Options group, click Add Row(s) > Change Calc Method.

If calc method controls are used in the sheet, this command is available only if the first row of the
selection is enabled for overwriting. If calc method controls are not used in the sheet, you can
change any rows.

Administrators and users with the Manage Calc Methods permission can always change calc
methods anywhere, regardless of calc method controls.
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NOTE: If only one calc method is allowed for changing the row at this location, then the menu
command is changed to Replace with CalcMethodName. When you select this command, the
listed calc method is automatically used for the change operation, and the Change Calc
Method dialog does not open.

3. Inthe Change Calc Method dialog, select the calc method to replace the selected row or rows,
and then click OK.

The available calc methods are listed in the left-hand side of the dialog. When you select a calc
method name, the properties of that calc method are displayed in the right-hand side of the
dialog, including a description. If you are unsure of which calc method to use, the descriptions
may provide guidance.

NOTES:
¢ The list of calc methods is limited to the allowed calc methods for this location (if
applicable). If you are an administrator or a user with the Manage Calc Methods
permission, all calc methods are listed.
¢ If you have selected a calc method with a different number of rows than the original
calc method, Axiom informs you of the row difference and asks you to confirm that you
want to continue. The sheet is adjusted accordingly for the additional or fewer rows.

4. If applicable, in the Calc Method Variables dialog, enter values for the calc method variables, and
then click OK.

If the calc method has variables, the values you enter for the variables are inserted in the
appropriate cells when the calc method is placed into the sheet.

This dialog only applies if the calc method has defined variables. Otherwise, Axiom does not
display this dialog and the change operation continues.

Calc method variables are an exception to the normal calc method changing rules. If you enter a
value for a variable, that value is always placed into the sheet when the calc method is changed.
However, if you leave a variable value blank, the normal change rules apply. Additionally, some
calc method variables are set up so that they are only displayed when the calc method is inserted,
such as a variable for selecting an account.

NOTE: If your plan files were configured to support double-click forms, you can open this
form again later by double-clicking the calc method in the sheet and change entries as
needed.

The selected calc method replaces the selected row or rows.
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Multiple-row calc methods and changing rows

You can replace single-row calc methods with multiple-row calc methods, and vice versa. The change
operation intelligently deletes rows and inserts rows, depending on the row difference between the
original calc method and the new calc method.

e If the new calc method has fewer rows than the original calc method, the additional rows in the
sheet are deleted.

e If the new calc method has more rows than the original calc method, additional rows are inserted
into the sheet.

For example, if you want to replace a single-row calc method with a five-row calc method, place your
cursor in the row with the existing single-row calc method. The change operation replaces the single
row with the first row of the five-row calc method, and then inserts four new rows to accommodate the
rest of the five-row calc method.

If you want to replace a five-row calc method with a three-row calc method, place your cursor anywhere
in the existing five-row calc method. The change operation replaces the first three rows of the five-row
calc method with the new calc method, and then deletes the extra two rows in the sheet.

4 N\
IMPORTANT: This procedure assumes that your system has enabled template validation. Use of

template validation allows Axiom to detect specific calc methods in the sheet, based on system-
generated codes. If your system is not using template validation, then you must highlight all rows of
the multiple-row calc method before you can change it. In the previous example, you would need to
manually highlight all five rows of the calc method within the sheet before changing it, because
Axiom would be unable to automatically detect the starting and ending rows.

Change calc method rules

End users can replace an existing calc method in the sheet by applying a new calc method, thereby
changing the calculations used on the row (or rows).

The following replacement rules apply when using the Change Calc Method feature. When creating calc
methods, keep these rules in mind so that change operations will work as desired.

The change operation is evaluated on a cell by cell basis. Actions depend on what the new calc method
(the calc method replacing the existing calc method) contains in each cell.

Desktop Client User Guide Axiom | 45



If the new calc The following action occurs:

method

contains:

Avalue ora The value or string in the new calc method is ignored, and the existing cell value
string is retained as follows:

¢ |f the existing calc method contains a value, a string, or is blank, then the
existing cell contents are retained as is.

¢ |f the existing calc method contains a formula, the value resulting from the
formula is retained by using Paste Special — Values. The formula is removed.
Formula The formula in the new calc method overrides the existing cell contents.

Empty cell The empty cell in the new calc method overrides the existing cell contents.

NOTE: The normal change rules do not apply to calc method variables. If the new calc method has a
variable defined, the variable value specified by the user always overrides the existing cell contents.
However, if the user does not specify a variable value (if the variable is not required and the user
leaves the entry blank, or if the variable is excluded from the change operation because it is set to
Insert Only), then the normal change rules apply to that cell.

Refreshing a plan file with data

The Refresh feature refreshes spreadsheet Axiom files with data from the database. In plan files, this
feature is available only to administrators and to users with the Run AQs in Plan Files security
permission. This control prevents users from inadvertently overwriting plan data when the template is
not designed to accommodate data updates.

For spreadsheet plan files, you might encounter two situations in which the Run AQs in Plan Files
security permission is not required to refresh data:

e If an Axiom query is configured to refresh when the file is opened, that refresh occurs for all
users, regardless of their security settings. Therefore, you may see data updates in the file when
it is first opened.

¢ |If the RunAxiomQueryBlock function is present in a sheet, any user can double-click the cell with
the function to run a designated Axiom query block, regardless of their security settings.

To refresh a plan file:

e On the Axiom tab, in the File Options group, click Refresh.

This option refreshes all sheets in the workbook. To refresh the current sheet only, click the down
arrow on the right-hand side of the Refresh button, and then click Refresh Active Sheet.

In systems with installed products, this feature may be located on the Main tab.
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You may be prompted to define values before the refresh occurs. If so, these values are applied to the
plan file to impact the data refresh.

TIP: You can also use F9 to refresh the entire workbook, and SHIFT+F9 to refresh only the active
sheet.

NOTE: Administrators can use the Refresh command on the Axiom Designer tab to perform more
targeted refresh actions, such as refreshing only a specific Axiom query.

Adding sheets to an Axiom file

Two different methods are available to add sheets to a spreadsheet Axiom file:
¢ Use normal spreadsheet functionality to add new sheets.
¢ Use the Add New Sheet feature.

» Adding sheets using spreadsheet functionality
If workbook protection is not applied to the Axiom file (or if you have permission to remove protection),
you can add new sheets using normal spreadsheet features.

¢ |n either the Windows Client or the Excel Client, access the Home tab, and in the Cells group, click
Insert > Insert Sheet.

¢ Inthe Excel Client, click the plus icon to the right of the sheet tabs.

After the sheet is added, you can rename it by double-clicking on the sheet name. We suggest
renaminge the sheet before adding it to the Control Sheet (if applicable).

If workbook protection is applied to the Axiom file and you do not have permission to remove
protection, n you cannot add new sheets unless the file is designed to use the Add New Sheet feature.

» Adding sheets using Add New Sheet

If your plan files, reports, or utilities allow adding new standard sheets, you can add these sheets using
the Add New Sheet feature. The new sheet is created by copying a designated master sheet, which
serves as the sheet template. If the file has multiple master sheets, you can select the master sheet to

copy.

The Add New Sheet feature is available only if the file has one or more designated master sheets. These
master sheets must be set up and enabled by the file designer.

To add a new sheet to an Axiom file:
1. Onthe Axiom tab, in the File Options group, click Add New Sheet.
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2. Inthe Add New Sheet dialog, complete the following:

¢ New sheet name: Type the name of the new sheet. This name cannot be the same as any
other sheet in the workbook, including the master sheets. We suggest avoiding spaces and
special characters in the name.

¢ Create from master sheet: Select the master sheet to copy to create the new sheet.

A | Add Mew Sheet =

Add a new sheet to the file, based on a master sheet.

Mew sheet name:

MNewbdachine

Create from master sheet;

Proposal

Request

Ok | | Cancel

3. Click OK to create the new sheet.

The new sheet is placed in the workbook as follows:

e If the workbook already contains copies of the selected master sheet, the new sheet is placed
after (to the right of) the most recently added copy.

¢ If the workbook does not already contain a copy of the selected master sheet, the new sheet is
placed after the master sheet, if it is visible. If the master sheet is not visible, the copy is placed
after the last visible sheet in the workbook.

NOTE: Added sheets cannot be printed using the Print Plan Files utility. If you need to print an
added sheet, you must do it by using Print within the file.

Viewing and managing file attachments for a plan file

Some file groups support the ability to attach supporting files to individual plan files. For example, in a
capital planning process, you may want to attach various supporting information about the capital
request, and have that information easily reviewable along with the plan file.

If you have read/write access to a plan file, you can add and delete attachments as well as view
attachments. If you have read-only access to a plan file, you can only view existing attachments.
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To access the file attachments for a plan file:
1. Open the plan file.

2. On the Axiom tab, in the File Options group, click File Attachments.

NOTE: In systems with installed products, this feature may be available in a different location.
It may be located on a different ribbon tab, or in a task pane, or by double-clicking a
designated area within the plan file itself.

One of two dialogs open, depending on your level of rights to the plan file:
e Users with read-only access see the Browse Attachments dialog, to view existing attachments.

e Users with read/write access see the Manage Attachments dialog, to view and manage
attachments.

NOTES:

* The features described in this topic apply to spreadsheet plan files. If you use browser-based
plan files (Axiom forms), the same general functionality is available, but the user interface is
different.

¢ This topic explains how end users can view and manage file attachments for their plan files. If
you are an administrator and want to learn more about enabling this feature for file groups
and managing it at the file group level, see the File Group Administration Guide.

» Browsing file attachments

The Browse Attachments dialog lists all current file attachments for the plan file. To open an
attachment, select the file in the list and click Open (or you can double-click the file).

How the attachment opens depends on the type of attachment. Excel-compatible files open directly in
the current Axiom session, in a new tab. Other file types open in their native application—such as Word
for a DOCX file, or Adobe Reader for a PDF file—assuming that application is available on your
computer.

» Managing file attachments
Using the Manage Attachments dialog, you can add, delete, and view attachments for a plan file.

e Adding a file attachment: Click Upload Attachment, and then navigate to the file to add as an
attachment. The file is imported into the Axiom database and associated with the plan file.

e Deleting a file attachment: Select the file to delete, and then click Delete. The file is deleted from
the Axiom database and is no longer available as an attachment.

e Renaming a file attachment: To rename a file attachment, right-click the attachment, and then
click Rename. The name becomes editable and you can type your changes.
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e Editing the attachment description: To define or edit the description for the file attachment,
select the file, and then click Edit Description.

e Opening a file attachment: Select the file to open, and then click Open (or you can double-click
the file).

If the attachment is an Excel-compatible file that opens within the Axiom session, the file opens with
read/write access. You can edit the file and save changes.

If the attachment is a Word file or a PowerPoint file, it opens in its native program with read/write
access, if the corresponding Axiom add-in is already installed (or if it is successfully installed when the
file is opened). You can edit the file and save changes by using the add-in.

If the Word or PowerPoint add-in is not installed, or if the file is some other file type, you cannot edit
and save the file directly. To edit one of these files, you should save a copy of the file locally and make
your edits. You can then delete the existing file attachment in the Axiom database and upload your
edited copy.

Saving a plan file

When you save a spreadsheet plan file, the following occurs:
e The plan file is updated in the Axiom file system.
e Data from the file is saved to the Axiom database.

To save a plan file:

On the Axiom tab, in the File Options group, click Save. (In systems with installed products, this feature
may be located on the Main tab.)

Before saving data to the database, Axiom performs an Excel calculation to update all formulas in the
sheet (including any Axiom functions), and validates the file. If errors are found, the file is still saved but
the data save is stopped and errors are displayed in the Save Errors pane. These errors must be
corrected before data can be saved to the database.

If no errors are found, the file and data are saved and a confirmation message appears. The
confirmation message includes information about the number of records saved (click Show Details to
see this information if desired).
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NOTES:
e Your file group security permissions determine whether you can save a plan file and/or save
data to the database.

¢ [f the plan file is active in a plan file process, your ability to save the plan file may depend on
whether you are the current task owner of the plan file. Also, if you are the current task
owner, you may be prompted to complete your active task as part of the save process.

e The save-to-database process occurs only if the file is configured to save data to the database.
However, most plan files are configured to save to the database.

¢ The file save does not occur if the plan file is a virtual plan file. Virtual plan files are not saved
as persistent plan files; instead, they are created as needed from the template each time they
are opened.

If the plan file is open as read-only, it cannot be saved. However, some implementations may use a
combination of read-only and save data permissions, where the plan file is a static input form and only
data is saved to the database.

» Additional save options

When you click Save, Axiom automatically performs all save actions that your user rights allow and that
the file is configured to perform. Use this default save behavior in the majority of cases. If necessary,
you can use additional save options to save onlye the plan file or save onlye the data.

For example, you may be in the process of inputting planning data into the file and you don't want to
save the data to the database until you have finished all your inputs. You can save just the plan file while
you are working, and when you are finished, perform a normal save.

IMPORTANT: If you save a plan file without performing a save-to-database (or vice versa), you might
cause a mismatch between the data in the file and the data in the database. Ideally, the plan file
save and the save-to-database should occur together, so that the database and plan files remain in
synch, and so that you can always track how a plan value was calculated.

To save only the file:
¢ |nthe Axiom tab, in the File Options group, click the down arrow to the right of the Save button,
and then click Save File Only.

The plan file is saved. All save-to-database processes are ignored.
This option is not available if the plan file is a virtual plan file.

To save only the data:
e In the Axiom tab, in the File Options group, click the down arrow to the right of the Save button,
and then click Save Data Only.
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Data from the file is saved to the database. The file itself is not saved.

NOTE: In systems with installed products, the additional save options may be located on the Main
tab or the options may not be available.

P Saving a copy of a plan file

To save a copy of a plan file for archive purposes, or to provide a copy to a non-Axiom user, use the
Snapshot feature to take a snapshot of the plan file. The snapshot process converts the file to a regular
Microsoft Excel file that can be used outside of Axiom. Axiom formulas are converted to values, so in
some cases you may not be able to determine how a plan value was calculated. For more information,
see Taking a snapshot copy of an Axiom file.

The Save As (Local) and Save As (Repository) options are not available for plan files. If a copy of a plan
file is saved outside of its file group, the plan file becomes disconnected from the file group and certain
functionality is lost. End users do not have a way to restore the copy to the file group. If an
administrator needs to export a copy of a plan file for purposes of development or support, the
administrator can use Axiom Explorer.

Completing a task in a plan file process

Plan files in a file group can be part of a defined planning process, which is a set of steps for plan files to
progress during a planning cycle. For example, you might have a basic process with two stages: one for
managers to develop the plans, and another for the Finance department to review and approve them.
Or you might have a multi-step plan which includes several passes of plan development and multiple
levels of review.

For each defined step of the process, each plan file has a designated owner. When the plan file isin a
step, that owner has a plan file task to perform one of the following actions:

e Edit the plan file and then submit it to the next step.

e Review the plan file and then approve it or reject it.

If you are a plan file owner, you are assigned a task and can view that task in the Process task pane. You
can review your assigned tasks and open the associated plan files using this task pane. You may also be
notified of the task via email.
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Example Process task pane with active tasks

If you are assigned a plan file task, it is your responsibility to complete the task by the specified due
date. You can open the plan file from the appropriate task pane (or using the normal file group menus)
and perform the necessary edits or review. When you are finished, you can complete the task from the
appropriate task pane. You may also have the option of completing the task as part of saving the file.

NOTE: When you are a plan file owner, your permissions to the plan file may be elevate" as
necessary to complete the current task. For example,you might typically have read-only access to a
specific plan file. However, if you are assigned a task that requires you to edit a plan file, your
permissions are elevated as needed so that you can edit the file and save its data. After you have
completed the task, your permissions returnn to normal levels.

When you have finished editing or reviewing a plan file for which you are the currently assigned owner,
you must complete the associated process task. You can complete this task using the Process task pane,
or as part of saving the plan file.

» Completing a plan file task using the Process task pane
You can complete your current process tasks using the Process task pane.

1. On the active step in the Process task pane, click one of the following actions (depending on the
step type):
¢ For edit steps, click Mark step as complete. This moves the plan file to the next step.

e For approval steps, click Process Actions > Approve if you approve the plan file and want
to move it to the next step. Click Process Actions > Reject if the plan file needs more work,
and you want to return to a prior step.
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NOTE: Some plan file processes may have an additional action of Deny request (or a
similar customized name). The deny action causes the plan file to be aborted in the
process, so that it no longer progresses. This action is intended for cases in which the
plan file should be completely removed from the process and never approved.

If you currently have more than one active plan file in a step, you can select a plan file before
clicking the appropriate action, and that plan file is then preselected for completion in the
Process Action dialog. You can also right-click a plan file to perform any of these actions.

2. Inthe Process Action dialog, do the following:

e If you currently have multiple active plan file tasks for this step, select the check boxes for
the plan file tasks that you want to complete right now. If you only have one active plan
file task (or if a plan file was selected in Process task pane before clicking the action), that
plan file is selected automatically and no check boxes are displayed.

* You can enter a comment to be stored in the process history and included in the email to
the next stage owner (if notifications are enabled). Comments can contain up to 1000
characters.

e If you reject the plan file, and the step is configured so that the step owner selects the step
to return to, you must select the step. The available steps are displayed in a drop-down list
in the Previous Step section.
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3. Click OK to complete the task.

After the background tasks are complete and the plan file is moved to the next (or prior) step, you are
no longer the step owner and the task is no longer displayed as active in the task pane.
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» Completing a plan file task when saving a plan file

Your system may be configured so that when you save a plan file for which you have an active process
task, you are given the option to complete the task after the save occurs.

NOTES:
¢ The option to complete a plan file task while saving is only available if the plan file is in a step
that allows edits. If the plan file is in an approval step that does not allow edits, you must use
the Process task pane to complete the task.

¢ This option applies only to spreadsheet plan files. If you work on a form-enabled plan file, you
cannot prompt the user to complete the task as part of a save. Instead, the plan file may
contain a button that allows you to complete the current task.

If the save is successful, a dialog similar to the following appears:

A Process Action X

& Perform process action for 'Budget Process’

Previous Step Current Step Next Step

D‘ Initial Submission t'j_, Management Approval Final Approval

& Jane Doe & v lendy Hunter [multiple step owners
() Return to previous step ®) Leave in current step () Advance to next step

Mo action will be taken for Dept 44500 (California Warehouse).

Comment Any comment will be stored with the process and included in notifications to the next step owner,

This dialog provides information about the current step for the plan file, as well as the next step and the
prior step (if applicable). Using this dialog, you can select one of the following options:

e Leave in current step (default): You remain the plan file owner and you can continue to work on
the plan file.

e Advance to next step: Select this option if you have completed work on the plan file and you are
ready to advance it to the next step. In most cases, you are no longer the plan file owner and you
can no longer edit the plan file.

e Return to previous step: Select this option if you want to reject the plan file and return it to a
previous step. This option is available only if the current step is an approval step. In most cases,
you are no longer the plan file owner and can no longer edit the plan file.

When rejecting the plan file, in some cases you may have the option to select the step that you want the
plan file to return to. In this case, the Previous Step box at the top of the dialog is interactive so that you
can select the target step.
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Some plan file processes may have an additional action of Deny request (or a similar customized name).
The deny action causes the plan file to be aborted in the process so that it no longer progresses. This
action is intended for cases in which the plan file should be completely removed from the process and
never approved. For example:

A | Process Action >

[OEL Perform process action for 'Capital Requests'

e

Previous Step Current Step Mext Step

D’ Initial Submission = Manager Approval Executive Approvals
& Rufus Xavier Sasparilla & Wendy Hunter (multiple step owners)
) Return to previous step ) Leave in current step ) Advance to next step

®) Deny request

The plan file process will be aborted for CapReq 34 (Equipment Maintenance).

Comment Any comment will be stored with the process and included in any notifications.

No budget available for the requestl

064 characters remaining

QK | | Cancel

Example process action dialog with a user-selects rejection step
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If you select any action other than leaving the plan file in the current step, you can enter an optional
comment to be saved in the process history and included in the notification to the next step owner (if

notifications are enabled).

Axiom only displays this process dialog if your system has been configured to prompt users about
process tasks when saving. Otherwise, you must use the Process task pane to complete plan file tasks.
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Using Reports

Axiom reports can query data from any table in the Axiom database. This section provides basic
information about spreadsheet-based Axiom reports and explains how to open existing reports and
refresh them with data.

For information on how to set up the data query for a report and how to configure other Axiom file
options, see the Axiom File Setup Guide.

In addition to the report-specific functionality detailed in this section, you can use standard Axiom file
features and tools. Report files use the same functionality as other Axiom files to perform actions such
as changing views or navigating to file bookmarks. For more information, see Using Axiom File Features
and Printing Files and other File Output Options.

About reports

Reports use Axiom file functionality to bring in data from the database, and if applicable, save data back
to the database. You can use any Axiom file feature in a report except calc method libraries.

Report files, unlike other Axiom files, are not associated with any file group. You can bring in data from
any table. For example, if you have two file groups that are configured to save data back to two different
tables (or to different columns in the same table), you can use a report to compare the data.

» Report structure

Axiom reports are free-format. When you create a new report, you can use various query options to
bring data anywhere into the report and use spreadsheet functionality to format the report and
calculate values such as subtotals and percentages.

Reports can have any number of sheets. You can configure each sheet to bring in data from the
database, and, if applicable, save data back to the database. To use an Axiom query on a sheet, or save
data to the database from a sheet, you must configure that sheet on the Control Sheet. Other Axiom file
functionality, such as Axiom functions or GoTo bookmarks, do not require the sheet to be configured on
the Control Sheet.
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» Reports Library
Report files are stored in the Axiom database. To make it easy to access and organize reports, Axiom

supports a virtual folder structure known as the Reports Library.

Each report is assigned to a folder in the Reports Library. When you open reports, you can navigate
through the Reports Library structure to quickly locate the report that you want to open.

The Reports Library is managed using Axiom Explorer. If you are an administrator, or if you have
Administer Axiom Explorer rights, you can use Axiom Explorer to create report folders, move reports
between folders, and delete existing reports. For more information on using Axiom Explorer, see the
System Administration Guide.

» Report output and distribution
In addition to the standard output options for Axiom files—such as the ability to take a snapshot of an

Axiom file—report files can use the File Processing feature.

Using file processing, you can refresh a report file and perform output and distribution actions such as
saving a snapshot copy of the file, emailing a snapshot copy of a file, or exporting data to a comma-
separated value (CSV) file or text (TXT) file. You can also process the file as is, or perform multipass
processing on the file, where the file is processed multiple times using a unique filter for each pass.

For more information, see Processing a report.

» Saving data to the database

In addition to viewing data, you can also use reports to calculate data and save data back to the
database. In certain circumstances, it might be more appropriate to use a report to save data rather
than plan files or driver files. If a report file is configured to save to the database, you can click Save n in
the File Options group to save data.

Contact your Axiom consultant if you are unsure about the best way to manage a certain set of data.

Opening a report
Axiom reports are organized by folder in the Reports Library. The specific report folders and files that

you can access and the level of access rights depend on your security settings. Administrators have full
access to all reports.

To open a report in the Reports Library:
1. Onthe Axiom tab, in the Reports group, click Reports to open the Reports menu.

TIP: You can also open reports from the Explorer task pane or Axiom Explorer.

2. Do one of the following:
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e Click All Reports to view the contents of the Reports Library within an Axiom grid. You can
then select one or more reports to open. You can sort, filter, and group the list using
standard Axiom grid features. For example, you can find a report by name by filtering on
the Document Name field.

e Use the Reports Library folders at the bottom of the menu to navigate to the specific
report to open. Report folders may have sub-folders.

NOTE: If another user adds a file or a folder to the Reports Library during the current session,
it may not be immediately visible to you. You can refresh your view by selecting Reports >
Refresh File System.

If a report is read-only, Axiom displays the text (R/0) in the file tab. Read-only reports cannot be saved.

NOTE: If another user has the report open as read/write, you can only open the file as read-only,
regardless of your security permissions.

» Advanced options

The following options are available in the Reports Library dialog, Axiom Explorer, and the Explorer task
pane:

e To open a report without refreshing Axiom queries that are configured to refresh on open, right-
click the file, and then select Open Without Refresh. This option is only available to
administrators.

e If you have read/write permissions to a report, but you want to open it as read-only to prevent
locking the file from other users, right-click the file, and then select Open Read Only.

» Opening non-managed report files

If you have a non-managed report saved to your local drive or a network folder, you can open it as
follows:

e In the Excel Client, use standard Excel functionality to open the file within Axiom.

* In the Windows Client, click the Axiom button in the top left-hand corner. Click Open, and then
navigate to the file.

Reports Library dialog

Use the Reports Library dialog to open one or more reports.

Although the primary purpose of the Reports Library is to store Axiom reports, other types of files can
be stored in the Reports Library. For example, Word files or PDF files could be saved in the Reports
Library, to provide users with supporting information for certain reports.
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» Report list

This dialog displays a list of all reports that you can access. The list of reports that you can access
depends on your file permissions in Security. Access can be granted by report folder, or by individual
files.

The list of reports is displayed in an Axiom grid. You can use standard Axiom grid features to sort, filter,
and group the list.

The following columns of information are displayed about each report. You can hide columns or show
additional columns by right-clicking the column header.

Column Description

Folder Path Displays the folder path where the report resides in the Reports Library.

By default, the list is sorted by folder path. If you want to view only the
reports for a specific folder, you can do one of the following using the
Axiom grid features:

¢ Right-click the column header and select Group by 'Folder Path'. The
list becomes grouped by folders. You can expand the folder that you
want to view.

e (Click the down-arrow button in the column header to open the
grouping and filtering dialog for the column. In the Equality section,
select the check box for the folder that you want to view. The list
becomes filtered to only show the contents of that folder.

To clear the grouping or filtering, right-click the column header and
select Clear Groupings or Clear All Filters.

Document Name Displays the name of the report.

Type Displays the file type of the report.

Axiom report files are either XLSM or XLSX. However, it is possible to
save other file types to the Reports Library.

If you open a file from the Reports Library that is not an Excel file, the
associated application will open if it is installed on your computer. For
example, if you open a PDF file from the Reports Library, it will be
opened within the local copy of Adobe Reader.

Locked By If the report is currently locked by another user, that user's name
displays in this column.

A report becomes locked if another user has opened the file as
read/write.

If the report is currently locked, then you can only open it as read-only.
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Column Description

Description Displays the description of the report.

Report descriptions are defined when the report is saved. The
description can also be edited using Axiom Explorer.

Last Modified Displays the date that the report was last saved.
Creation Date Displays the date that the report was created in the Reports Library.
» Actions

To open reports, select one or more files in the list, and then click OK.

The following additional actions are available by selecting one or more reports and then right-clicking
the selection:

e Open Read Only: Open the report(s) as read-only. You might do this if you want to look at a
report, but you do not want to lock it for editing. Other users can still open the file as read/write.

e Open Without Refresh: Open the report(s) without running any Axiom queries that are set to
refresh on open. This option also ignores the Downgrade to read-only on open setting. This
option is only available to administrators.

Creating a new report

You can create a new report if you have read/write access to at least one folder in the Reports Library.
You can use any of the following methods to create a new report. If you do not have these permissions,
the associated menu options for creating new reports are not available to you.

NOTE: After saving a new report to the Axiom file system, you may not see that new report
displayed in Axiom Explorer or the Reports menu until the file system has been refreshed. You can
go to Reports > Refresh file system to manually trigger a refresh and cause the new report to be
displayed.

» Creating a new report using the Report Wizard

You can create a new report using the Report Wizard. In the wizard, you make selections regarding the
type of report to create and the applicable data, and then the wizard creates a report based on your
choices. You can then further modify the report as needed.

To create a new report using the Report Wizard:

On the Axiom tab, in the Reports group, select Reports > Report Wizard.

For more information about the Report Wizard and what types of reports and what types of reports you
can create, see the Axiom File Setup Guide.
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» Creating a new blank report

You can create a new report from scratch using the default blank report template. This template is
entirely free-format.

If your organization has saved additional report templates, you can also use them to create a new
report. Only administrators can create new report templates.

To create a new blank report:

¢ On the Axiom tab, in the Reports group, select Reports > New Report.

If your system has multiple report templates, you can select the templateto use from this menu.
Otherwise, the default Report Template is used atomatically .

A new report file contains a Control Sheet and one or more blank sheets. Name one of the blank sheets
and configure it on the Control Sheet. You can use the Sheet Assistant or manually type the sheet name
into the Control Sheet.

You can now use Axiom file functionality on this sheet, such as using Axiom queries to bring in data. For
more details on setting up Axiom files, see the Axiom File Setup Guide.

Certain features do not require the sheet to be set up on the Control Sheet. For example, to use only
Axiom functions to query data (such as GetData), you do not have to use the Control Sheet. However, in
most cases, you must configure used sheets on the Control Sheet.

» Saving a new report

To save a new report, click Save in the File Options group of the Axiom tab. When you save the new
report for the first time, you are prompted to define a file name and select a folder location in the
Reports Library. You can also define a description for the report.
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You must have read/write permissions to a folderto save a report there. Axiom displays a lock icon next
to folders for which you do not have read/write permissions. If you have access to a My Documents
folder, you can also save reports there for your own use.

If you later decide to change the file name, location, or description, you can use Axiom Explorer. If you
do not have rights to access Axiom Explorer, you can edit the description by using Save As (Repository)

(save the file with the same name and location, but edit the description).

You can also save the report to your local drive or to a network location using Save As (Local File). In this
case, the report is not stored in the Axiom database and is considered to be a non-managed file.

NOTE: Access to certain task panes (such as the Sheet Assistant) may depend on security
permissions that are defined at a folder level. When a new report file is created, the file location is
assumed to be the root of the Reports Library until the file is saved. Therefore. access to task panes
for new reports depends on the user's permissions that are defined at the Reports Library level. If a
user does not have permission to the task panes at the Reports Library level, but does have access at
a sub-folder level, the user cannot see the task panes until they save the file to that sub-folder.

P Creating a new report based on an existing file

You can use Save As to create a new report based on a copy of an existing report. You can save the
copied file to the Reports Library or as a local, nonmanaged file.
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You can also create a report based on an existing Excel file by opening the Excel file in Axiom.To use
certain Axiom file features such as Axiom queries, you must add a Control Sheet to the report. Then, you
can use Save As (Repository) to save the file to the Reports Library.

Refreshing a report with data
To update a spreadsheet Axiom report with the most current data from the database, refresh the file. A
refresh does the following:
e Updates active Axiom queries with data, according to the update settings defined for the query
e Updates Axiom functions with data
e Performs an Excel calculation

e Reapplies the currently active views (if applicable)

To refresh a report:

On the Axiom tab, in the File Options group, click Refresh.

This action refreshes all sheets in the workbook. To refresh the current sheet only, click the down arrow
on the right-hand side of the Refresh button, and then click Refresh Active Sheet.

In systems with installed products, this feature may be located on the Main tab.

You may be prompted to define values before the refresh occurs. If so, these values are applied to the
report to impact the data refresh.

TIP: You can also use F9 to refresh the entire workbook, and SHIFT+F9 to refresh only the active
sheet.

NOTE: Administrators can use the Refresh command on the Axiom Designer tab to perform more
targeted refresh actions, such as refreshing only a specific Axiom query.

Applying a Quick Filter to a report

Using the Quick Filter feature, you can apply a temporary filter to a report. This allows you to quickly
view the data at a different level of detail, without needing to alter the report configuration.

For example, you may be viewing an Income Statement report for the entire consolidated organization,
and you want to view the same report at a different level of detail, such as for just North America or just
the South region. You can use the Quick Filter to recalculate the report at the desired level of detail, and
then clear the filter when you are done.

The Quick Filter is combined with your table security filters and any filters that are currently defined in
the report, such as sheet filters and filters defined for Axiom queries.
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To apply a Quick Filter to a report:
1. Onthe Axiom tab, in the File Options group, click Quick Filter.

Hsave ~ [2refresn ~ 2 Quick Filter
Iﬁ] Change View - @l\ Drill =
= GoTo - Freeze Panes

NOTE: In systems with installed products, this feature may be located on the Main tab.

2. At the top of the dialog, specify how the filter should be applied:
* Workbook (default): The Quick Filter is applied to all sheets in the workbook.
¢ Active Sheet: The Quick Filter is only applied to the currently active sheet.

This selection may determine which hierarchies and tables are available in the dialog to build the
filter. See Hierarchy and table availability in the Quick Filter dialog.

3. Inthe Quick Filter dialog, define a filter using one of the following methods:

e Data Hierarchies: Select the desired hierarchy levels(s) from the hierarchies listed in the
dialog. As you select items in the hierarchy, the corresponding filter is automatically built
in the Filter box.

For example, you might have a hierarchy named Geography, which has local regions rolling
up into countries, and countries rolling up into world regions. You can select the desired
items that you want to see in the report, such as Europe, Asia, or North America as world
regions. For more information and examples, see Understanding hierarchy-based Quick
Filters.

e Manual Filter: You can manually type a filter into the Filter box using standard filter
criteria statement syntax. Fully qualified Table.Column syntax must be used.

e Advanced Filter: Click Advanced Filter to create a filter using any reference table columns
(not just hierarchy columns).
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A | Cuick Filter ? =

{I Edit the Quick Filter far the active sheet or workbook.

Apply Filter To: ® Workbook () Active Sheet

-

Data Hierarchies

— ) Adwvanced Filter
. Option1: Selectvalues  k
PEEE E TELE from hierarchies to auto- /l‘f

I 5% Accounts | Create afilter Option 3: Click

4 % Geography \"'_:

to switch to the

v [] WorldRegion - Asia region Advanced Filter

A WarldRegion Corporate - Corporate departments

A WarldRegion Europe - Europe region

A WarldRegion Morth America - North America region
I % Managerial

Option 2: Type afilter
| directly in the Filter box

Filter: T/

OK

Example Quick Filter dialog

4. Click OK.

If the Quick Filter is applied to the entire workbook, a warning message informs you that the
entire workbook will be refreshed. If you do not want to see this message again in the future,
select Don't show this message again. Click OK to continue.

If the Quick Filter is applied to the current sheet, that sheet is refreshed and no warning message
appears.

If the file has been configured with GetCurrentValue("QuickFilter") functions, then these functions will
display the currently applied Quick Filter for your reference. If not, you can view the current Quick Filter
by clicking the Quick Filter button again. The current filter displays in the Filter box.
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» Clearing the Quick Filter

Once a Quick Filter has been applied to a report, the filter remains applied until one of the following
occurs:

e The file is closed. Quick Filters cannot be saved in the file and are always cleared when the file is
closed.

e A new Quick Filter is applied by using the Quick Filter button and selecting a different filter.

e The Quick Filter is manually cleared. To clear the Quick Filter, click the Quick Filter button again
and then click Clear Filter.

» Hierarchy and table availability in the Quick Filter dialog

The hierarchies and tables shown in the Quick Filter dialog are based on the Axiom queries in the report.
Axiom looks up the primary tables for the queries, and only shows the hierarchies and reference tables
that are relevant to those primary tables. This is done to help ensure that the Quick Filter will be
applicable to at least one query in the report.

If the filter applies to the entire workbook, then Axiom looks at the primary tables for all Axiom queries
in the workbook. If the filter applies to the active sheet only, then Axiom looks at only the primary tables
for the Axiom queries defined on the active sheet.

If the primary table of an Axiom query has multiple lookup paths to a reference table, Axiom must be
able to choose one of the paths in order to apply a Quick Filter using that reference table. Axiom will
automatically prioritize and use one of the lookup paths if it meets one of the following criteria (listed in
order of priority):

e Avalidated column on the primary table (key or non-key) has the same name as the reference
table

e The primary table has only one single-level lookup to the reference table (regardless of how many
multi-level lookups are present)

e The primary table has only one key column that looks up to the reference table (regardless of
how many other single-level non-key lookups are present)

If the spreadsheet report has multiple Axiom queries where the primary tables look up to the same
reference table, the reference table will display in the Quick Filter dialog as long as all of the primary
tables meet one of these rules, so that the resulting Quick Filter can be applied to all of the queries.

If a primary table has multiple lookup paths to a reference table and one path cannot be prioritized
using the previously described criteria, then the reference table will be omitted from the Quick Filter
dialog. As an alternative, the primary table itself will display in the Quick Filter dialog, so that a specific
path can be selected through the primary table and therefore avoid any ambiguity. For example, if the
primary data table has two non-key columns named PrimaryPhysician and SecondaryPhysician that both
look up to Physician.Physician, then the selection must be made through the primary data table so that
the correct path to Physician.Physician is used.
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EXCEPTION: If the primary table of one of the Axiom queries is the reference table, then the reference
table will display in the Quick Filter dialog even if the report contains an Axiom query where the primary
table does not meet one of these rules. In this case, an ambiguous column error will occur if you
attempt to create a Quick Filter using the reference table.

NOTE: If the report uses GetData functions instead of an Axiom query, then all hierarchies and
reference tables are listed in the dialog because Axiom cannot determine the "primary table" in this
context. In this case, it is possible to define a Quick Filter that does not apply to any GetData
functions in the workbook. If this occurs, the filter will simply have no effect.

» Understanding hierarchy-based Quick Filters

When you use hierarchies to create a Quick Filter, Axiom automatically creates the filter based on your
selections. When only one item it selected, the filter is simple—only data that matches the selected item
is included. For example, if you select Asia from a Geography hierarchy, you will get a filter something
like: Dept.WorldRegion="Asia’.

A | Quick Filter ? X

1' Edit the Quick Filter far the active sheet or workboolk.

Apply Filter To: ® Workbook () Active Sheet

Data Hierarchies Advanced Filter
<type here to filter values>
I % Accounts
4 & Geography
I WorldRegion Asia - Asia region
I [] WarldRegion Corporate - Corporate departments
I [] WarldRegion Europe - Europe region
I [] WarldRegion Morth America - North America region
b & Managerial
Filter: Clear Filter ¥

DEPT.WorldRegion = "Asia’

QK | | Cancel

Simple Quick Filter
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NOTE: Sometimes when you select a single "child" item underneath a "parent" item, the child and
parent will be joined with AND. For example: DEPT.VP="'Jones' AND DEPT.Manager='Smith'.
This means that the DEPT table has other instances of Manager Smith that belong to different VPs,
so the compound statement is to ensure that you only get the data where Manager Smith is under
VP Jones. (You can manually edit the filter to remove the Jones portion of the statement if you want
to see all data for Manager Smith, regardless of VP). If instead Axiom constructs the filter as just
Dept.Manager='Smith', that means all instances of Manager Smith are also under VP Jones.

You can select multiple items in the same hierarchy or from different hierarchies. Items from the same
hierarchy are combined using OR, which means data matching any of the selected items is included.
Items from different hierarchies are combined using AND, which means only data that matches both
selected items is included.

A | Cuick Filter ? >

1' Edit the Cuick Filter for the active sheet or workboolk.

Apply Filter To: ® Workbook () Active Shest

Data Hierarchies Advanced Filter
<type here to filter values:
I & Accounts
4 & Geography
I WaorldRegion Asia - Asia region
b [ World Region Corporate - Corporate departments
I WorldRegion Europe - Europe region
b [ World Region Morth America - Morth America region
I % Managerial
Filter: Clear Filter %

DEPT.WarldRegion in (‘Asia’, 'Europe’)

QK | | Cancel

Example 1

In example 1, we have selected two items from the same grouping level in a single hierarchy, so a simple
filter criteria statement is created using IN. The resulting filter will include all data from Asia and Europe.
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A Quick Filter ?

‘I Edit the Quick Filter far the active sheet or workbook.

Apply Filter To: ® Workbook () Active Sheet

Data Hierarchies Advanced Filter

<type here to filter values>
I & Accounts
4 5 Geography
A WarldRegion Asia - Asia region
A WarldRegion Corporate - Corporate departments
4 [m] WarldRegion Europe - Europe region
v ] Country France

I Country kaly
b [] Country UK

4 (] World egicn MNorth America - Morth America region
o Country USA

— [m]

] Region US Central - United States Central Sales Region
I Fegion US East - United States Eastern Sales Region
b Region US West - United States Western Sales Region

I % Managerial
Filter: Clear Filter %
DEPT.Country = 'ltaly' OR DEPT.Region = 'US East'
OK | | Cancel

Example 2

In example 2, we have selected two items from different grouping levels, but within the same hierarchy.

In this case a compound filter criteria statement is created using OR. The resulting filter will include all
data that belongs to either Italy or US East.

Desktop Client User Guide Axiom | 72



A | Cuick Filter ? *

1' Edit the Quick Filter far the active sheet or workbook.

Apply Filter To: ® Workbook () Active Sheet

Data Hierarchies Advanced Filter
<type here to filter values:
I & Accounts

4 5 Geography
b [ WarldRegion Asia - Asia region
b [ WarldRegion Corporate - Corporate departments
b [ WarldRegion Europe - Europe region
4 [m] WarldRegion Morth America - North America region

4 [m] Country USA
b Region US Central - United States Central Sales Region
I Fegion US East - United States Eastern Sales Region
b Region US West - United States Western Sales Region
4 % Managerial
b [ vP Bree Sigrman
I /P David Prince
b [ VP Diana Prince
I [] vP Evan Simpson
Filter: Clear Filter %

(DEPT.Region = 'US East’) AND (DEPT.VP = "David Prince’)

| QK | | Cancel

Example 3

In example 3, we have selected two items from different hierarchies, so a compound filter criteria
statement is created using AND. The resulting filter will include only data that belongs to both US East
and VP David Prince.

Processing a report

If a report is set up to use file processing, you can process the report to automatically perform the
following actions:

¢ Save snapshot copies of the file and automatically email them to various recipients.
e Export data in the file to a comma-separated values (CSV) or text (TXT) file.

e Save data in the file to the database as part of a multipass process.

¢ Collect multiple output files into a single report package.
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e Process multiple reports in batch.

This topic explains how to process a file that is already configured for file processing. For details on how
to set up a file for file processing, see the Axiom File Processing Guide.

NOTES:
¢ The File Processing menu command and the associated task pane are available only to
administrators or users with the Allow File Processing permission for the current file.

¢ You can set up other file types to use file processing, but the most common use is in a report.

To process a file using file processing:

1. Open thefile. If you want to see what the file is configured to do during file processing before
executing it, you can check the settings in the File Processing task pane.

2. Inthe File Processing task pane, in the Actions section, click one of the following options to start
processing:
e Process File: The file is processed once "as is." The file is refreshed and the file processing
action is performed. No multipass filter or settings are applied.

e Process File Multipass: The file is processed multiple times, with a unique filter applied for
each pass. For example, if the file is set up to process by DEPT, then the file is processed
once for each department. The data queries in the file are automatically filtered to return
data for the current pass department only.

TIP: You can also process the file using the File Processing menu on the Axiom tab. (In
systems with installed products, this feature may be located on the Main tab.)

Once file processing is initiated, the following occurs:

e The file is refreshed. If you are performing multipass processing, the file is refreshed using a data
filter for the current pass item.

e The file processing action is performed. If you are performing multipass processing, the action
may be performed after each pass, or it may be performed once all passes are complete,
depending on the file processing settings.

A status bar displays the progress of the file processing. When the processing is complete, a
confirmation box displays information about the process, such as how many passes were performed,
how many files were created, etc.

Note that the file itself is not saved as part of file processing. You can process a file even if you have
read-only rights to the file. However, if the file processing is set up to save to the database, you must
have rights to save data for that file.
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Saving a report

When you save a report, the report file is updated in the Axiom file system. If the report is configured to
save data to the database, a save-to-database also occurs.

To save a report:

On the Axiom tab, in the File Options group, click Save. (In systems with installed products, this feature
may be located on the Main tab.)

Your file permission settings in Security determine whether you can save a specific report. If a report is
opened with read/write permissions, you can save it. If the report is opened as read-only, the report file
cannot be saved, but you may still be able to save data. You may also be able to save a copy of the
report.

NOTE: Some files may use a Control Sheet setting that causes the data in the report to zero when
the file is saved. This is a security precaution that is typically enabled in reports only. Click Refresh to
restore the data.

» Save-to-database reports

Some reports may be configured to save data to the database. If the report is configured to save to the
database, the file is validated before saving. If errors are found, the file is still saveds but the data save is
stopped and the errors are displayed in the Save Errors pane. These errors must be corrected before
data can be saved to the database. If no errors are found, a confirmation message indicates the number
of records that were saved.

Your file permission settings in Security determine whether you can perform a save-to-database for a
specific report. Note that the permission to save data is managed separately from the file access
permission. Therefore, it is possible to have read-only permissions for the file, but still have rights to
save data (or you could have read/write permissions for the file, but not the rights to save data).

When you click Save, Axiom automatically performs all save actions that your user rights allow and that
the file is configured to perform. You can use the additional save options to only save the file, or to only
save data.

To save only the file:

In the Axiom tab, in the File Options group, click the down arrow to the right of the Save button, and
then click Save File Only.

The plan file is saved. All save-to-database processes are ignored.

To save only the data:

In the Axiom tab, in the File Options group, click the down arrow to the right of the Save button, and
then click Save Data Only.

Data from the file is saved to the database. The file itself is not saved.
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NOTE: In systems with installed products, the additional save options may be located on the Main
tab. In all systems, you can also access these options by right-clicking the file tab.

» Saving a copy of a report

You can save a copy of a report using Save As features. You might want to save a copy of a report to use
as a starting point for a new report or to create an archive copy before making changes to the report.

In most cases, you should save the report to the Axiom file system (in the Reports Library). However, it is
possible to save report files outside of the Axiom system (as non-managed files). Nonmanaged files have
limited functionality and are not covered by Axiom security or included in system processes.

To save a copy of a report to the Reports Library:

1.

4.
5.

On the Axiom tab, in the File Options group, click the down arrow to the right of the Save button,
and then click Save As (Repository).

TIP: The Save As options are also available by right-clicking the file tab.

NOTE: By default, this dialog only displays files with the same file extension as the current file.
To view all file types when using this dialog, select View > Show All Files. This setting is
remembered for future sessions.

In the left-hand side of the dialog, navigate to the folder in the Reports Library where you want to
save the file.

You must have read/write permissions to a folder to save a copy of the report. Axiom displays a
lock icon next to folders where you do not have read/write permissions to any folder in that
folder tree.

In the File name box, type a name for the new report.
(Optional) In the Description box, type a description for the report.

Click OK.

To save a copy of a report locally (as a non-managed file):

1.

2.

On the Axiom tab, in the File Options group, click the down arrow to the right of the Save button,
and then click Save As (Local File).

TIP: The Save As options are also available by right-clicking the file tab.

Navigate to the applicable location on your local computer or on a network file share, and then
click Save.
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You can change the name of the file and its file format when saving. In the Excel Client, you can
save the file using any file format that your Excel version supports. In the Windows Client, you
can save the file as XLSM, XLSX, or XLS.
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Using Axiom File Features

Axiom files support a number of features that can be used in plan files, reports, and any other type of
Axiom file.

Changing views in an Axiom file

If views are defined for a sheet in a spreadsheet Axiom file, you can change how information is
presented in the sheet.

For example, you might have the option to switch between a Detail sheet view and a Summary sheet
view, or you might have the option to toggle certain rows and columns as hidden or shown to select
which quarters you want to view. The available view options depend on the file design.

To change the views in a sheet:

On the Axiom tab, in the File Options group, click Change view.

NOTE: In systems with installed products, this feature may be located on the Main tab.

A menu displays all views that are defined in the current sheet. You can click a view name to activate
that view.

Some views are single-selection, which means that activating one view deactivates the prior view. Other
views allow for additive selections so that multiple views can be active at the same time. Some views
may open a dialog where you can select specific sets of rows or columns to be displayed. The specific
behavior of each view depends on the file designer.

After you make any view active, the freeze panes setting for the sheet is also reapplied. Axiom tracks the
active views in a sheet and reapplies them after you perform certain activities in a sheet, such as
refreshing an Axiom query or inserting a calc method.

Jumping to GoTo bookmarks in an Axiom file

If an Axiom file has bookmarks defined in the file, you can go directly to bookmarked points by using the
GoTo feature.
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To go to a bookmark:

On the Axiom tab, in the File Options group, click GoTo.

NOTE: In systems with installed products, this feature may be located on the Main tab.

A list of bookmarks appears underneath the GoTo button. For example, you might see a set of
bookmarks for each sheet in the file.

Selecting a set brings up a list of bookmarks in that set. Click a bookmark in the list to go directly to that

area.
= GoTo -
||=|:| Budget Summaries ¢ Budget Summaries actions on sheet Budget
E | Payroll » => | Statistics
Revenue
Marketing
Creerhead

Travel

L TR0 N 0 2

Orther Expenses

Example GoTo bookmarks

Freezing or unfreezing panes in a sheet

You can configure sheets in Axiom files to automatically freeze panes at a certain location when the file
is opened. You can toggle these frozen panes on and off using the Freeze Panes option.

This option is available only if the sheet is not protected. If you have security rights to unprotect the
sheet, the Freeze Panes option becomes available after the sheet is no longer protected.

To freeze or unfreeze panes in a sheet:

On the Axiom tab, in the File Options group, select or clear the Freeze Panes check box.

NOTE: In systems with installed products, this feature may be located on the Main tab.

If panes are frozen, clearing the check box unfreezes the panes.

If panes are unfrozen, selecting the check box freezes the panes. If a sheet has freeze panes settings
configured on the Control Sheet, selecting the check box applies that setting, regardless of where your
cursor is in the spreadsheet. Otherwise, the Freeze Panes option works like the Microsoft Excel feature
and freezes panes at the current cursor position.
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NOTE: If you have toggled freeze panes off, and then you use Change view to select a view (or if you
otherwise perform an action that causes a view to be reapplied), the freeze panes settings for the
sheet are reapplied.

Administrators can also use the Show Everything command to turn off all protections and display
controls at the same time, including frozen panes.

Drilling the data in an Axiom file

Axiom provides various options to drill the data in an Axiom file:

 Drill down. You can drill down in a data row to view the data at a different level of detail. If
hierarchies were set up for your data, you can drill down predefined hierarchy levels. You can also
drill down to the bottom of the data or select any relevant column for drilling.

e Drill through. You can drill through the data in a specific cell to view the associated sub-GL detail
or transactional data. This feature is available only if drill through is enabled for the source data,
using drill-through definitions.

e Custom drilling. You can drill data using Axiom's custom drilling feature. Custom drilling is
extremely flexible and can be set up to drill virtually any source data, at any user-defined drilling
level. Custom drilling must be set up in advance for the report, and requires advanced report
writing knowledge to configure.

Drilling data: Using Drill Down

You can drill down a row in an Axiom file to view the data at a different level of detail. For example, if a
row of data in the report shows budget totals for the Northwest region, you can drill the row to see the
values for each individual department in that region. This type of drilling is known as drilling down.

You can use drilling down in report files or plan files, but the most typical use case is in reports. In plan
files, most data is already at the lowest level of detail, so drilling down may only be useful if the plan file
has a summary sheet with drillable data.

If a row is eligible for drilling, you can drill down hierarchies that were set up for the data. For example,
your system may have a Geography hierarchy such as: Country > Region > DEPT. You can also drill
directly to the bottom of the data (all dimensions) or drill using any related column in the data.

You can drill data rows that result from an Axiom query or that are built using GetData functions. A few
limitations apply, and some advanced configurations have special behaviors. For more details, see the
drill down setup discussion in the Axiom File Setup Guide.

You can disable drilling on a per sheet level. If drilling is disabled for a sheet, the Drill option is disabled
while you are on that sheet. Consider taking this action if the data on the sheet is not conducive to
drilling.
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To drill down a row of data:

1. Place your cursor in the row of data to drill.

If you drill a row of data that is part of a multiple-row calc method,place your cursor anywhere in
the multiple-row calc method. The drill results will be for all rows of the calc method.

2. On the Axiom tab, in the File Options group, click Drill, and then select the applicable drill level
from the Drill Down sub-menu.

NOTE: In system with installed products, this option may be located on the Main tab.

Drill option Description

Hierarchies Your system may have defined hierarchies that outline logical drilling
paths. For example, you may have a Geography hierarchy that allows
you to drill from Country to Region to individual departments.

Hierarchies are defined per dimension (on the relevant reference
table), and are specific to your system.

On the Drill menu, hierarchies are listed first if defined. Only
hierarchies relating to the current data are shown.

NOTES:

¢ [f the data to be drilled comes from multiple data tables, only the
hierarchies from shared lookup reference tables are available.

e |f you drill an Axiom query, hierarchy options are disabled on the
menu if you are already at that level of detail. For example, if the
report is at the VP level already, VP is disabled on the menu.
However, when you drill GetData functions, all hierarchy options
are present on the menu, because the GetData functions may all
have different sum by levels.

All Detail Selecting All Detail takes you directly to the bottom of the data.
Essentially, you are drilling based on all dimensions at the same time,
rather than on one specific dimension.

The drill sheet contains one column for each dimension (key column)
in the data, including a description column for each (if applicable).

NOTE: If the row contains data from more than one data table, this
option is available only if the tables share the same key columns and
all of the key columns are lookup columns.
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Drill option Description

Choose Columns Select Choose Columns to drill based on any relevant column for the
current data, including non-lookup key columns.

In the Select Columns dialog, select the column (or columns) to drill
by. You can select from any column in the primary data table, as well
as any column in lookup reference tables.

This drilling option is free-format. No validation occurs to determine if
a specific column selection makes sense in relation to the current
data.

NOTES:
e Calculated fields are not displayed and cannot be used for drilling.

e |f the row contains data from multiple data tables, you can only
select columns from shared lookup reference tables.

Atemporary file Drill Filename.x1lsx is opened. This file contains a drill sheet named Drill_
DrillLevel that shows the results of the selected drill. The top of the drill sheet displays your current drill
context.

To continue drillingl, you can do either of the following:

e Return to the original sheet (or a different sheet) in the original file, and then select a new drill
level. If you left the temporary drill file open, a new drill sheet is added to that file, with the new
drill results. If you closed the temporary file, Axiom creates a new temporary file.

e Select a row in the drill sheet and continue drilling to a lower level of detail. A new drill sheet is
created in the temporary file with the results.

When you are finished viewing the drill results, close the temporary file. While it is possible to use Save
As to save the temporary file, this process is often not useful. You can perform the drill again at any time
to view the results. If you perform the same drill multiple times, consider creating a new report that
displays the data at the applicable level. To share the drill results with someone else, create a snapshot
copy of the temporary drill file.

Double-click drilling

If Axiom double-click actions are enabled for the sheet, you can drill a row of data by double-clicking it.
In this case, a dialog displays the drilling options for the current row selection. Select the applicable drill
level, and then click OK.

NOTE: Certain double-click actions may take priority over drilling.
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Drilling data: Using Drill Through

You can drill a specific data point in an Axiom file to view the associated sub-GL detail or transactional
data. This feature is only available if drill through is enabled for the source data using a drill-through
definition.

You can use the drill-through featurein either report files or plan files.

You can drill data values that result from an Axiom query or from a GetData function. A few limitations
apply, and some advanced configurations have special behaviors. For more details, see the drill through
discussion in the Axiom File Setup Guide.

You can also disable drilling on a per sheet level. If drilling is disabled for a sheet, the Drill option is
disabled while you are on that sheet. You can disable drilling if the data on the sheet is not conducive to
drilling.

To drill through the data in an Axiom file:
1. Place your cursor in the cell that contains the value you want to drill.

2. Onthe Axiom tab, in the File Options group, click Drill, and then select the desired drill from the
Drill Through sub-menu.

NOTE: In system with installed products, this option may be located on the Main tab.

If Drill Through is not listed on the drilling menu, then the selected cell is not eligible for drill
through.

A temporary file opens, named Drill Filename.x1lsx. This file contains a drill sheet named Drill_
DrillLevel, that shows the results of the selected drill. The top of the drill sheet displays your current drill
context.

NOTE: When you drill through data, you drill from the source table to an entirely different table that
holds the detailed data. The data results are entirely dependent on the drill-through configuration
(unlike drill down, where the drill data is queried from the same table and derived
programmatically). If the drill results are not as you expect, please contact your system
administrator.

Double-click drilling

If Axiom double-click actions are enabled for the sheet, then you can drill a data value by double-clicking
it. In this case, a dialog opens, listing the drilling options for the current selection. Select the desired drill
level and then click OK.
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Drilling data: Using custom drilling

If an Axiom file is set up for custom drilling, you can drill the data in the file to view it at a different level
of detail or view a set of related data. Custom drilling is most often used in reports, but it can be applied
to any Axiom file.

Each sheet can have one or more custom drilling options. Custom drilling is completely configurable and
can be set up to return any set of data. If you have any questions about the custom drill options in a
specific file, contact the report designer or a system administrator.

Initiate custom drilling by double-clicking a row or using the Drill menu. Double-click drilling is only
available if one of the drilling options in the file is configured to use it. Otherwise, you can initiate all
active custom drills from the Drill menu. If custom drill options are available for the file, they are listed
under the subhead Custom Drrills.

If a file is not set up for custom drilling, only the built-in drilling options are displayed on the Drill menu.

To drill the data in an Axiom file using custom drilling:
1. Do one of the following, depending on the applicable drill and how the file is configured:
e Double-click the row to drill.

e Place your cursor in the row to drill. On the Axiom tab, in the File Options group, click Drill,
and then select a drill option listed under the Custom Drills subhead.

TIP: You can also initiate drills from the right-click context menu.

2. If the drill option requires you to select a drilling level, the Drill dialog displays the available levels.
Select a level, and then click OK.

If the drill option has just one level, this step does not apply.

A report file displays the results of the selected drill. This target drill report is a separate file that is
opened using your normal file security rights. When you are done viewing the drill data, you can close
the report.

NOTE: When custom drilling, drill results are presented differently than when using the built-in
drilling features. Custom drilling uses a separate target report that is configured to present the drill
results. You cannot continue drilling the target report unless the target report is also configured to
support custom drilling (or unless the data in the target report is eligible for built-in drilling).
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Printing Files and other File Output
Options

Axiom has a variety of features to create file output and share data with people throughout your
organization.

Printing an Axiom file

You can print a spreadsheet Axiom file on a per-sheet basis. You can print one or more sheets or all
available sheets.

Each sheet can have one or more defined print views. Use the print views to define different views of
the sheet and set certain standard print options, such as the print orientation. For example, for a plan
file, you might have one print view that prints a summary view of the sheet (with certain columns and
rows hidden for printing), and another print view that prints a detail view of the sheet (with all columns
and rows visible).

If a sheet has no predefined print views, you can print the sheet using the settings defined for the
spreadsheet using standard Excel printing features. For more information on defining print settings for a
spreadsheet, see the Microsoft Excel Help. In the Windows Client, the spreadsheet print settings are
defined in the Workbook Explorer, in the Page Setup section for each sheet.

NOTE: You can always print the file using standard spreadsheet print functionality, even if Axiom
print views are defined.

To print an Axiom file:
1. Onthe Axiom tab, in the File Output group, select one of the following:
¢ To select print views from all sheets in the workbook, click Print.

e To print only the current sheet, click the arrow to the right of the Print button, and then
click Print This Sheet.

NOTE: In systems with installed products, this feature may be located on the Main tab—
either directly on the ribbon or under Publish.
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The Print Sheets dialog lists the available print views for the entire workbook or for the current
sheet, depending on how you entered the dialog. To sort this list by the Sheet Name or Print View
Name, click the column header.

A | Print Sheets - Budget-2020_984011020000.xsx ? >
Eﬁ Select the sheets and the views that you wish to print.
L] Sheet Name Print View MName Print Details Print Preview
L] Summary Summary View,/Edit Print Preview
] Surmmary Variance View/Edit Print Preview
O Stat_Rev Annual View View/Edit Print Preview
[ ] stat_Rev Monthly View View/Edit Print Preview
[ Stat_Rev Projection View View/Edit Print Preview
[l Expense Annual View View/Edit Print Preview
[l Expense Maonthly View View/Edit Print Preview
[l Expense Projection View View/Edit Print Preview
L[] Jobcode Monthly Dollars View  View/Edit Print Preview
[ Jobcode Monthly FTEs View View,/Edit Print Preview
[] Jobcode Monthly Hours View View/Edit Print Preview
] lobcode Summary View View/Edit Print Preview
Current Printer: Y\skifps01.kaufmanhall.net\KH5ecurePrint
| Choose Printer... | Print

Example Print Sheets dialog

NOTES:

¢ |f a sheet does not have a defined print view, it is listed with a print view name of
Default and uses the print settings defined for the spreadsheet.

¢ You cannot print Control Sheets using the Axiom printing feature, whether they are
visible or hidden. To print a Control Sheet, use the standard spreadsheet printing
features.

2. Inthe Print Sheets dialog, select the sheet/print view combinations that you want to print.
To print all print views for all sheets, select the check box in the column header to select all.

If you opened this dialog by using Print This Sheet and the sheet has only one available print
view, that view is selected by default.

3. You can also do any of the following before printing:
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e View and edit the print settings. To view and potentially change the print settings for a
selected view, click the View/Edit link. In the Print Options dialog, you can change any of
the print settings, for the current print job only (the changes are not saved in the file).

* Preview a print view. To preview a print view, click the Print Preview link. The native
spreadsheet Print Preview feature displays a preview of the print job. You can preview only
one viewat a time.

* Select a printer. To print to a different printer than your default printer, click Choose
Printer at the bottom of the dialog. In the Printer Setup dialog, select the printer to use,
and then click OK.

NOTE: In the Windows Client, the printer is always your default printer unless you
change it for a specific print job. In the Excel Client, the printer starts as your default
printer, but if you change the printer for a print job, the selection is carried forward for
any future print jobs in the current session.

4. Click Print.

Print Options dialog

The Print Options dialog displays the print settings for the current print view. You can edit settings for
the current print job only. Any changes you make are not be saved in the file.

NOTE: Print options are read-only when using the Print Plan Files option to print multiple plan files.

This dialog displays all settings that are applied to the print job, whether the setting is defined in the
associated Print tag or inherited from the spreadsheet settings. If a setting is blank,that print option is
not defined and is be applied to the print job.

Print View Options

Item Description

Print View Name The name of the current print view.

View Name The name of the sheet view to be applied when printing. These are the
same sheet views that are available from the Change View menu.

For example, if the sheet view is configured to hide columns or rows,
those columns and rows are hidden in the print copy. Row and column
sizing is also applied.

Paper Size The paper size for the print job, either Letter or Legal.
Orientation The print orientation for the print view, either Portrait or Landscape.
Repeat Rows The rows to repeat at the top of the page. Rows must be specified as a

range; for example: 1: 3.
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Item Description

Repeat Columns The columns to repeat at the left of the page. Columns must be
specified as a range; for example: A:C.

Scaling
Iltem Description

Fit To Pages Wide The number of pages on which to fit the print area. For example, if you
want the print area to fit on one page, specify 1.

Percent Zoom The percent zoom to apply to the print range. Specify the number
without a percent sign. For example, to zoom by 90%, specify 90.

Headers and Footers

Left Header Header text to be displayed in the left-hand side of the header.
Center Header Header text to be displayed in the center of the header.

Right Header Header text to be displayed in the right-hand side of the header.
Left Footer Footer text to be displayed in the left-hand side of the footer.
Center Footer Footer text to be displayed in the center of the footer.

Right Footer Footer text to be displayed in the right of the footer.

Printing multiple plan files

You can print multiple plan files in batch by using the Print Plan Files feature. Select multiple plan files
within a file group, and then select one or more print views for each plan file. The available print views
for each plan file are based on the template that was used to create the plan file.

To print multiple plan files from a file group:

1. Onthe Axiom tab, in the File Output group, click the down arrow to the right of the Print button,
and then click Print Plan Files.

NOTE: In systems with installed products, this feature may be located on the Main tab, either
directly on the ribbon or under Publish.

TIP: If you have access to the file group menu for a file group, you can access Print Plan Files
from the file group menu. In this case, the current file group is preselected in the dialog.
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2. Inthe Print Plan Files dialog, use the File Group list to select the file group that contains the plan
files to print.

You can print only one file group at a time. After a file group is selected, the dialog displays a list
of the available plan files.

3. Inthe Select plan files to print section, select the plan files to print.

* You can sort and filter the list using standard Axiom grid functionality to find the plan files
to print.

e To select multiple plan files at the same time, highlight the plan files, and then right-click
and select Select. to print all plan files that are displayedy in the dialog, select the check
box in the header row.

After you select at least one plan file, you can select which print views to print.

4. Inthe Select views to print section, select the views to print. You must select a view for each
source template for the selected plan files.

Select views to print: & Select at least one print view per ternplate

Print Views Template

0 zelected Select print views Budget Template

e Click the Select print views link.

* In the Select Print Views dialog, select the sheet/print view combinations to print, and
then click OK.

To view the settings to be applied to the print job, click the View link. Print settings are
read-only in this context.

NOTE: All template sheets are listed in this context (except for Control Sheets),
including sheets that you may not typically see in plan files because they are hidden. If
you select a sheet that is hidden in one of the selected plan files, it is not be printed. A
message informs you of the unprinted sheet when the printing process is complete.

e Repeat this process for each source template.

If the selected plan files were built using the same template, only one template is listed. If the
selected plan files were built using multiple templates, multiple templates are listed. The print
selections for each template apply only to the plan files that were built using that template.

5. To print to a different printer than your default printer, click Choose Printer. In the Printer Setup
dialog, select the printer to use, and then click OK.
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NOTE: In the Windows Client, the printer is always your default printer unless you change it
for a specific print job. In the Excel Client, the printer starts as your default printer, but if you
change the printer for a print job, that selection is carried forwardd for future print jobs in the
current session.

6. Click Print.

If a selected print view is not found in a target plan file, a message lists the affected plan file and the
relevant sheet/print view. This issue may occur if the print views in either the template or the plan file
were modified after plan file creation.

Running file processing on an Axiom file

If a file is set up to use file processing, you can process the file to automatically create various file
outputs:

e Save snapshot copies of the file and automatically email them to various recipients.

e Print one or more sheets in the file using one or more print views.

e Export data in the file to a comma-separated values (CSV) or text file.

e Collect multiple output files into a single report package.

e Process multiple reports in batch.

You can use file processing in all spreadsheet Axiom files except file group templates; however, report
files are the most common use case.

NOTE: The file processing menu command and the associated task pane are available only to
administrators and to users with the Allow File Processing permission for the file.

To process a file using file processing:

1. Open the file. If you want to see what the file is configured to do during file processing before
executing it, you can check the settings in the File Processing task pane.

2. Inthe File Processing task pane, in the Actions section, click one of the following options to start
processing:

e Process File: The file is processed once "as is." The file is refreshed and the file processing
action is performed. No multipass filter or settings are applied.

e Process File Multipass: The file is processed multiple times, with a unique filter applied for
each pass. For example, if the file is set up to process by DEPT, then the file is processed
once for each department. The data queries in the file are automatically filtered to return
data for the current pass department only.

TIP: You can also process the file using the File Processing menu on the Axiom tab. (In
systems with installed products, this feature may be located on the Main tab.)
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Once file processing is initiated, the following occurs:

e The file is refreshed. If you are performing multipass processing, the file is refreshed using a data
filter for the current pass item.

¢ The file processing action is performed. If you are performing multipass processing, the action
may be performed after each pass, or it may be performed once all passes are complete,
depending on the file processing settings.

A status bar displays the progress of the file processing. When the processing is complete, a
confirmation box displays information about the process, such as how many passes were performed,
how many files were created, etc.

Note that the file itself is not saved as part of file processing. You can process a file even if you have
read-only rights to the file. However, if the file processing is set up to save to the database, you must
have rights to save data for that file.

Taking a snapshot copy of an Axiom file

You can take a snapshot of a spreadsheet Axiom file so that you can save a copy as a normal Excel file
and then open it in Microsoft Excel (without needing Axiom). For example, you may want to send a copy
of a report to someone who does not have access to Axiom.

When you create a snapshot of an Axiom file, the file is copied as an XLSX file, and the following occurs:

¢ All Control Sheets and any hidden sheets are automatically removed. You can include all
remaining sheets, or only the active sheet.

e All Axiom formulas are replaced with values. You can retain Excel formulas or replace them with
values. If Excel formulas are preserved, certain formulas are replaced with values if they
reference sheets or cells that are deleted as part of the snapshot processing.

e Rows and columns that are flagged for deletione are deleted.
Due to the file format, any Visual Basic Application (VBA macros) in the file are also removed.

To take a snapshot of an Axiom file:
1. Open the file in Axiom.

2. Onthe Axiom tab, in the File Output group, click Snapshot.

NOTE: In systems with installed products, this feature may be located on the Main tab, either
directly on the ribbon or under Publish.

3. Inthe Formula Replacements section, select one of the following:

e Convert All Formulas (default): All formulas are replaced with values.
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e Retain Excel Native Formulas: All Excel formulas in the spreadsheet are retained as is, with
one exception. If a cross-sheet formula references a sheet that is not present in the
snapshot (depending on the Sheets To Snapshot setting), that formula is replaced with
values.

NOTE: If the file contains a pivot table, this option must be selected in order for the
pivot table to work in the snapshot copy.

4. Inthe Sheets to Snapshot section, select one of the following:
e Limit to Active Sheet (default): Include only the active sheet in the snapshot.

e All Sheets In File: Include all sheets in the file (except any Control Sheets and hidden
sheets, which are always removed).

5. Click OK.

The snapshot file is created and is opened in Axiom. The navigation tab for the file is titled either
Sheetname_snapshot (if the snapshot contains only one sheet) or FileName_snapshot (if the snapshot
has multiple sheets). You can now use Save As features to save the file locally or to a network location.

NOTE: If you use the Excel Client and want to save a copy of the snapshot as a PDF file, you can use
standard Excel functionality to do so. Use File > Save As, and then select PDF as the file type. This is
an Excel-specific feature that is not available in the Windows Client.

To email a snapshot to someone directly, use the E-Mail Workbook feature. This feature creates a
snapshot and attaches it to an email (instead of opening it in Axiom).

Emailing a snapshot of an Axiom file

You can email a snapshot of a spreadsheet Axiom file using the E-mail feature. Axiom creates a snapshot
copy of the file and attaches it to an email. The copy can then be viewed outside of Axiom by someone
who may have not have access to the system. When you use this feature, Axiom creates a snapshot
copy of the file as if you used the Snapshot feature.

The email can be sent using your default email client (such as Microsoft Outlook), or you can send the
file using the Axiom Scheduler email service. Note that the Scheduler email service does not support
HTML format for email.
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NOTES:

¢ The name of the emailed file is either Sheetname_snapshot (if the snapshot contains only
one sheet) or FileName_snapshot (if the snapshot has multiple sheets). The name cannot be
changed.

¢ You can also email snapshot copies using the File Processing feature. Use file processing when
you want to automate the process and employ multipass processing to send the same file to
different people using different data. The emaill feature is best used to send "one-off"
snapshots as needed.

To email a snapshot copy of an Axiom file:
1. Open the file in Axiom.

2. Onthe Axiom tab, in the File Output group, select E-mail.

NOTE: In systems with installed products, this feature may be located on the Main tab, either
directly on the ribbon or under Publish.

3. For Send As, select Snapshot.
4. For Send using, select one of the following:

¢ Outlook: Send the email using the default email client on your local machine (for example,
Microsoft Outlook). The name of this option may be customized for your organization.

e Axiom Mail Service: Send the email using the Axiom Scheduler email service.
5. Complete the following Snapshot Options in the dialog:

Option Description

Send file as Select XLS, XLSX, XLSM, or PDF. XLSX is selected by default.

Include Select one of the following:

e Entire Workbook: All sheets are included in the snapshot (except
Control Sheets and hidden sheets, which are always removed).

e Active Worksheet Only (default): Only the active worksheet is
included in the snapshot.
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Option Description

Formulas e Convert All Formulas (default): All formulas are converted to values.

e Retain Excel Native Formulas: Axiom formulas are converted to
values, but Excel formulas are left as is. Note that if an Excel formula
references a sheet that is not included in the snapshot, that formula
will be converted to a value.

NOTE: If the file contains a pivot table, this option must be selected in
order for the pivot table to work in the snapshot copy.

This option does not apply if PDF is the selected file type.

6. Click OK.

If you send the file using your default email client, a new email message opens with the snapshot file
attached. You can specify the recipient, subject, and body text for the email, and then send it.

If you send the file using the Axiom mail service, an E-Mail dialog opens so that you can specify the
recipient, subject, and body text for the email. In the address boxes (To, Cc, and BCC), you can either
type an email address or click the button to select an Axiom user. If you select a user, the email is sent
using the user's email address as defined in Axiom security. When you click OK, the email settings are
saved to the database, to be sent the next time the Scheduler SMTP Email Delivery task is run.

Notes for administrators

If desired, you can customize the name of the default email client option. By default, "Outlook" is used
because most clients have Microsoft Outlook on their client machines. To customize the name, use the
DefaultEmailClientName system configuration setting. For more information, see the System
Administration Guide.

Emailing a hyperlink to an Axiom file

You can email a hyperlink to a spreadsheet Axiom file using the E-mail feature. Axiom creates a URL
hyperlink to the file and includes it in an email. The email recipient can click on the link to launch the
system and open the file directly, assuming that the recipient is an Axiom user who has rights to access
the file.

The email can be sent using your default email client (such as Microsoft Outlook), or you can send the
file using the Axiom Scheduler email service. Note that the Scheduler email service does not support
HTML format for email.
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NOTES:

¢ You can obtain a URL to an Axiom file in a variety of ways, and then paste it into an email that
you create manually. For example, you can use GetDocumentHyperlink or right-click a file in
Axiom Explorer to obtain a URL. The email hyperlink feature is provided as a convenience to
quickly send a hyperlink to the current file.

¢ You cannot use the email hyperlink feature to send a hyperlink to open a form-enabled file as
an Axiom form; the source file is alwayse opened as a spreadsheet.

e The hyperlink included in the email uses the same format as hyperlinks generated using
GetDocumentHyperlink, including the differing URL format for systems using Security
Assertion Markup Language (SAML) or OpenlD Authentication.

To email a hyperlink to an Axiom file:
1. Open the file in Axiom.

2. On the Axiom tab, in the File Output group, select E-mail.

NOTE: In systems with installed products, this feature may be located on the Main tab—
either directly on the ribbon or under Publish.

3. For Send As, select Document Link.
4. For Send using, select one of the following:

e Outlook: Send the email using the default email client on your local machine (for example,
Microsoft Outlook). The name of this option may be customized for your organization.

e Axiom Mail Service: Send the email using the Axiom Scheduler email service.

5. Optional. Complete the Document Link Options in the dialog:

Option Description

Sheet Filter (Optional) Enter a filter to apply to the file when it is opened. You can
type the filter statement or use the Filter Wizard.

The filter is applied like a Quick Filter and affects any data queries in the
file. For example, Dept .Region="West ' means that all data queried is
limited to the West region.

You can also specify a table or table type to apply the filter to using the
same filter syntax that is available for the GetDocumentHyperlink
function. In this case, you must manually type the filter syntax because
the Filter Wizard does not account for this type of syntax.
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Option Description

Cell Address (Optional) Specify the cell to be made active when the document is
opened (for example, Sheet1!D22).

If the specified location is not typically in view, the file is scrolled to that
location; otherwise the file opens in its default view with the cursor
placed at that location.

6. Click OK.

If you send the hyperlink using your default email client, a new email message opens with the hyperlink
included in the body text. You can enter the recipient, subject, and additional body text for the email,
and then send it.

If you send the hyperlink using the Axiom mail service, an E-Mail dialog opens so that you can enter the
recipient, subject, and additional body text for the email. In the To and Cc boxes, you can either type an
email address, or click the button to select an Axiom user. If you select a user, the email is sent using the
user's email address as defined in Axiom security. When you click OK, the email settings are saved to the
database, to be sent the next time the Scheduler SMTP Email Delivery task is run.

Notes for administrators

If desired, you can customize the name of the default email client option. By default, "Outlook" is used
because most clients have Microsoft Outlook on their client machines. To customize the name, use the
DefaultEmailClientName system configuration setting. For more information, see the System
Administration Guide.
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Reference

Axiom grids

Axiom grids are used in dialogs throughout Axiom, to display lists of information. These grids offer many

ways to group and filter the information.

Dept

11000
20000
21000
22000

[-]

Cescription |E|
Balance Sheet
Corporate
Corporate Administration

Information Technologies

Regicon

Corporate
Corporate
Corporate

Corporate

|E| Country

UsA
USA
UsA
USA

ve  [+]

Michelle Choi
Michelle Choi
Ciconmor

Frank Martinez

You can change the order of columns by dragging and dropping, and you can sort by clicking a column

header.

» Filtering the list

Filtering can be especially helpful when you need to select items to include in a utility or other process.
Generally, you can filter the list to show a subset of items, and then select only the items that are shown

in the dialog.

To filter a column, click the down arrow button |L] in the column header. This brings up a grouping and

filtering dialog for the column.

The filtering options depend on the type of column. Use one of the following:

e Equality: Select a value to show items that exactly match that value. You can select multiple
values to match.
e Contains: Type a value to show items that contain that value. For example, to show all

departments with the text "Overhead" somewhere in the name.

e Range: Specify a range of values to show items that fall within the range (inclusive). For example,

to display all departments from 20000 to 30000.
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Columns are filtered as soon as you select a filtering option. The OK button on the grouping and filtering
dialog is only to close the dialog. You can press the ESC key to close the dialog and cancel the filter.

Once a column is filtered, the arrow button changes to show a filter icon |£], so that you know the
contents of the column are filtered. You can define filters for multiple columns.

To clear afilter for a single column, click the filter button in the column header, and then click Clear
Filters. To clear all filters, right-click in the column header and select Clear All Filters.

For example, if you want to filter the list to show a specific subset of departments, you could set a range
as follows:

A | Process Plan Files ? x
.
?5 Process Plan Files for Budget
Options | Plan Files | Axiom Queries
Specify plan files to process: @) Choose from list ) Use filter ) All
Selected plan files: 0
O Dept E‘ Nescrintinn =1 File Exists E‘ Country E Region E‘ VP E‘ Locked By E‘
0 20000 Equality RUE usa Corparate Michelle Chai
O 21000 10000 RUE usa Corparate Michelle Chai
0 22000 111000 RUE usa Corparate Bree Sigman
1 23000 120000 RUE usa Corparate Michelle Chai
1 24000 21000 RUE usa Corparate Michelle Chai
1 25000 [J22000 RUE UsA Corporate Bree Sigman
1 26000 23000 RUE UsA Corporate Michelle Chai
[1 27000 124000 RUE UsA Corpaorate Michelle Choi
] 2eo000 [ 125000 RUE Usa Corpaorate Michelle Choi
[1 29000 [ 26000 RUE USA US West Bree Sigman
9
[ 127000
Range
From | 20000
To 30000 |

If you only want to run the utility on this subset of departments, you can select the check box in the
header, and only the displayed departments will be selected.

If all of these departments belonged to the same region, or had the same VP, you could achieve the
same effect by filtering on the Region or VP column, but this time selecting a specific region or VP to
filter the list.
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» Grouping the list

To group the information by a column, click the button in the column header (it is either an arrow
button or a filter button, depending on whether the column has been filtered), and then click Group By.

The list is grouped by the selected column:
¢ To expand a grouping and see the items in a group, click the down arrow by a group name.

e To contract a grouping and hide the items in a group, click the up arrow by a group name.

Once the list has been grouped, a group icon appears in the column header |:2 (not on the button) to
signal which column the list is grouped by. Only one level of grouping can be applied; if you choose to
group by a different column, then the current grouping is cleared and the new grouping is applied.

To clear a grouping, click the button in the column header of the grouped column, and then click Clear
Grouping. You can also right-click the column header and select Clear All Groupings.

For example, you could group the Browse Reports Library dialog by folder path:

A | Reports Library ? *

r Browse Reports Library

Folder Path T :|E| Document Mame E Type |E| Locked By |E| Description

(%) \Axiom\Reports Library\Archive: 6 item(s)
() \Axiom\Reports Library\Budget Reports: 7 item(s)

“axiomiReports Librany\Budget Tie cut monthly data xlsx
‘AxiomiReports Libran\Budget Monthly report package xlsx
“AxiomiReports Librany\Budget Variance by Acct xlsx
\AxiomiReports Librany\Budget Dept Subtotals Klsx
“AxiomiReports Librany\Budget Budget Comparison xlsx
YAxiom\Reports Libran\Budget Acct Subtotals xlsx
“AxiomiReports Libran\Budget Income Statement By Month xlsx

@ Vxiom\Reports Library\File Processing: 6 item(s)
@ \Axiom\Reports Library\Forms\Archive: 28 item(s)

(]

Cancel

» Hiding and showing columns
In most grids, you can hide columns and you can display additional columns.

e To hide a column, right-click the header for that column, and select Hide ColumnName. You
cannot hide a column if it is the key column for the list.
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e To show a column, right-click anywhere in the column header to bring up the list of available
columns, and then select the desired column to add it to the grid. You can also hide columns
using this list, by clearing the check box next to the name of the column that you want to hide.

Column changes apply to the current dialog session only. The next time that you open the dialog, the
default columns display.
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multipass processing
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My Documents 12
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opening 30

printing 85

refreshing 46

saving 50

tasks

process 52

printing

Axiom files 85

multiple plan files 88
process management

Process task pane 16
Process task pane

using 16

Q

Quick Filter
applying to a report 66

hierarchy filter examples 70
R

recent items 26
refreshing files with data
plan files 46
reports 66
rejecting a plan file 52
reports 59
about 59
creating 63
drilling
performing a drill 80
favorites,saving as 24
opening 60
printing 85
refreshing with data 66
Reports Library 60
saving 63,75
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saving files 5
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locally 5-6

plan files 50

reports 63,75

to the Reports Library 5-6
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taking a snapshot copy 91
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in grids 97
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completing 16
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